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FOREWORD 

 

Dr.Ishari K Ganesh 
Chancellor 

 

Vels Institute of Science, Technology and Advanced Studies (VISTAS), deemed to be a 

university, was established in 2008 under section 3 of the Act of 1956 of the University Grants 

Commission, Government of India, New Delhi. 

VISTAS has blossomed into a multi-disciplinary Institute offering more than 100 UG & PG 

Programmes, besides Doctoral Programmes, through 18 Schools and 46 Departments. All the 

Programmes have the approval of the relevant Statutory Regulating Authorities such as UGC, 

UGC-DEB, AICTE, PCI, BCI, NCTE and DGS. 

The deemed to be University aims to provide innovative syllabi and industry-oriented 

courses, and hence, the revision of curricula is a continuous and ongoing process. The revision 

is initiated by the faculty depending on the requirement and approved by the Board of Studies 

of the concerned Department/School. The courses are under Choice Based Credit Systems 

that enable students to get adequate freedom in choosing subjects. 

I am pleased to inform you that VISTAS has been rendering its services to society to 

democratize the opportunities of higher education for those who are in need through Open 

and Distance Learning (ODL) mode. 

VISTAS ODL Programmes offered have been approved by the University Grants Commission 

(UGC) – Distance Education Bureau (DEB), New Delhi. 

The curriculum and syllabi have been approved by the Board of Studies, Academic Council, 

and the Executive Committee of the VISTAS, and they are designed to help provide 

employment opportunities to the students. 

The ODL Programme (B.Com., BBA and MBA) study material have been prepared in the Self 

Instructional Mode (SIM) format as per the UGC-DEB (ODL & OL) Regulations 2020. It is 

highly helpful to the students, faculties and other professionals. It gives me immense pleasure 

to bring out the ODL programme with a noble cause of enriching learners’ knowledge. I 
extend my congratulations and appreciation to the Programme Coordinator and the entire 

team for bringing up the ODL Programme in an elegant manner. 

At this juncture, I am glad to announce that the syllabus of this ODL Programme has been 

made available on our website, www.vistas.ac.in, for the benefit of the student fraternity and 

other knowledge seekers. I wish that this Self Learning Materials (SLM) would be a nice 

treatise to the academic community and everyone. 

 

CHANCELLOR 

 

http://www.vistas.ac.in/


                                                                    FOREWORD 

 

                                                          Dr.S.Sriman Narayanan 
                                                                   Vice-Chancellor  
 

My Dear Students! 

Open and Distance Learning (ODL) of VISTAS gives you the flexibility to acquire a University 

degree without the need to visit the campus often. VISTAS-CDOE involves the creation of an 

educational experience of qualitative value for the learner that is best suited to the needs 

outside the classroom. My wholehearted congratulations and delightful greetings to all those 

who have availed themselves of the wonderful leveraged opportunity of pursuing higher 

education through this Open and Distance Learning Programme. 

Across the world, pursuing higher education through Open and Distance Learning Systems 

is on the rise. In India, distance education constitutes a considerable portion of the total 

enrollment in higher education, and innovative approaches and programmes are needed to 

improve it further, comparable to Western countries where close to 50% of students are 

enrolled in higher education through ODL systems. 

Recent advancements in information and communications technologies, as well as digital 

teaching and e-learning, provide an opportunity for non-traditional learners who are at a 

disadvantage in the conventional system due to age, occupation, and social background to 

upgrade their skills. 

VISTAS has a noble intent to take higher education closer to the oppressed, underprivileged 

women and the rural folk to whom higher education has remained a dream for a long time. 

I assure you all that the Vels Institute of Science, Technology and Advanced Studies would 

extend all possible support to every registered student of this deemed to be university to 

pursue her/his education without any constraints. We will facilitate an excellent ambience for 

your pleasant learning and satisfy your learning needs through our professionally designed 

curriculum, providing Open Educational Resources, continuous mentoring and assessments 

by faculty members through interactive counselling sessions. 

This university brings to reality the dreams of the great poet of modern times, Mahakavi 

Bharathi, who envisioned that all our citizens be offered education so that the globe grows 

and advances forever. 

I hope that you achieve all your dreams, aspirations, and goals by associating yourself with 

our ODL System for never-ending continuous learning. 

With warm regards, 

   

VICE-CHANCELLOR 



Course Introduction 

The Course DCMBA-17: Computer Applications for Business has been divided in to 

five Blocks. The main objectives is to encourage to think the essential concepts 

necessary to make effective use of the computer and to understand what a computer 

can do, how it works, and how it can be used to create Documents using word 

processing and spreadsheet applications for personal and business use. Also to 

presents a new concepts using PowerPoint presentation.  

Block-1: Introduction to Computer provides a basic understanding of the Computer 

Applications. Unit-1 describes the early history of Computer and Unit- 2 discusses 

Types of Computer, Unit- 3 deals with Functions of Computer and Unit -4 discusses the 

Applications and current trends for business related problems. 

Block-2: Hardware and Software deals with Hardware and Software systems. Unit-5 

discusses with Hardware system, Unit-6 details the Storage, Input and Output 

devices, Unit- 7 deals Operating systems and the Unit-8 elaborates Applications 

software and Internet. 

Block-3: File Operations details Microsoft Word. Unit-9 discusses the MS-Word 

History, versions, Unit-10 details the Formatting, Editing, Paragraph alignment, Unit -

11 explains the Header and Footer, Insertion of Page number, and Unit-12 details the 

Inserting table, symbol and Print command.  

Block-4: Microsoft Excel discusses MS-Excel. Unit-13 discusses History and 

versions of MS-Excel, Unit-14 details the File creation, Unit-15 explains Formatting, 

editing and organizing of Worksheet, Unit-16 deals with Formulas and Functions and 

the Unit -17 presents about creating charts. 

Block-5: Microsoft PowerPoint explores the MS-PowerPoint. Unit-18 discusses the 

History and Version, the File creation, Slide Creation. Unit -19 deals with the Formatting 

and the Unit -20 explores the Editing, Adding Transitions and Animations. 
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Unit- 9 Microsoft Word  76 

Unit- 10 Formatting and Editing of paragraph 81 

Unit- 11 Inserting header and footer and page number 85 

Unit- 12 Inserting tables, print review and printing 89 

Block-4: Microsoft Excel 

Unit- 13 Microsoft Excel Introduction 94 

Unit- 14 Features of Excel  99 

Unit- 15 Formatting the worksheet 105 

Unit- 16 Formulas and Functions 113 

Unit- 17 Creating Charts 122 

Block-5: Microsoft PowerPoint 

Unit- 18 Microsoft PowerPoint Introduction 127 

Unit- 19 Features of PowerPoint  134 

Unit- 20 Editing and Animation 139 

Plagiarism Certificate 146 
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Block-1:  Introduction  

Block-1: Introduction to Computer has been divided into four Units 

(Unit-1 to Unit-4). 

Unit-1: History of Computer – Definition deals with basic understanding 

of the Computer Applications, Overview of Computer and History of 

Computer. 

Unit-2: Types of Computers presents about the various Types of 

Computers, various Desktop Computer and Laptop.  

Unit-3: Functions of computer explains about the various Functions of 

Computer, Computer Devices, Computer functionality  

Unit-4: Application and Current Trends for Business Related 

Problems describes about Current systems, Business computer and 

Application and current trends for business related problem. 

In all the units of Block -1: Introduction to Computer, the Check your 

progress, Glossary, Answers to Check your progress and Suggested 

Reading has been provided and the Learners are expected to attempt all 

the Check your progress as part of study.  
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Unit-1 
History of Computer – Definition 

STRUCTURE 

Overview 

Objectives 

1.1. Introduction 

1.2. Overview of Computer  

1.3. History of computer 

1.4. Summary 

Let us Sum up 

Check your progress 

Glossary 

Answer to check your progress 

Suggested Reading 

Overview  

In this unit the learners will learn and study about the basic functionality 

of computer applications and central focus on complete operations of 

computer process along with workflow diagram. The basic details about 

computer thoughts and ideas are well detailed with examples and 

illustrations. 

Objectives  

After studying this unit, you should be able to:  

• understand the evolution of computers;  

• classify computers on the basis of purpose, size and technology;  

• describe the various components of computers;  

• explain how computers are useful in various areas;  

• understand the advantages and disadvantages of computers;   

• differentiate computers from smart phones.  

1.1. Introduction 

 In the era of machines, computer is the greatest boon to the mankind. 

The thought came when people wanted a device which could help in 

calculating problems but now it has become a life savior to human beings 

and we cannot think of life without computers. Today the word “computer” 
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is not only confined to PC’s but also includes laptops, tablets, smart 
phones, Electrocardiogram (ECG) machines, etc. This unit would help in 

understanding the origin and evolution of computers, its classification on 

the various bases, its components and its applications in today’s world. 
The unit also makes the learner to know about certain advantages and 

disadvantages of computers. Fundamentals of Computers  

1.2. Overview of Computers  

A Computer is basically a programmable electronic device which accepts 

data, performs operations on the given data and presents the results and 

can also store the data or results as per the requirements. Computers are 

general purpose information machines that can perform a variety of tasks 

on data. These tasks are all related to the four basic computer operations 

i.e. to accept data (input), process the data, produce output, and store 

(storage) the results as needed.  

These days computers do not only come in the form of personal 

computers (PC), but have taken various shapes. Computers are designed 

to do everything with available pool of information and are popularly used 

for controlling small and large machines which would have otherwise be 

controlled by human. Computers have made their presence in every field 

and they have their significance almost in every sphere. Computers have 

taken various forms in contemporary world. Almost everyone use a 

personal computer at their work space or in their home for performing 

tasks such as doing calculations, getting information, watching movies, 

formulating documents, organizing meetings, writing etc.  

1.3. History of Computer  

When introduced first early in 1940’s, computers were very capacious 

electronic devices that needed bunches of people to handle and operate 

them. But with the passing of time and evolution of technology, computers 

of today are very astounding and have gone through a complete 

overhauling.  

Computers of now are so tiny that they can fit on your desk, on your lap, 

or even in your pocket and they are now thousands of times more 

expeditious. However, there are six apparent generations of computers 

which are explained below. Every generation of computer is well-defined 

by a paramount technological development which changes necessarily 

how computers operate leading to more compressed, inexpensive, but 

more dynamic, effective and booming machines.  
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1) First Generation (1940-1956):  

The first generation computers used vacuum tubes for circuitry and 

magnetic drums for memory. The size of first generation computers were 

very huge taking up the space of almost an entire room. They were very 

costly to operate and in addition used a large amount of electricity and 

used to produce lots of heat, which was often the cause of malfunction. 

These first generation computers relied on ‘machine language’ (which is 
the most fundamental programming language that can be understood by 

computers). These computers were used to solve only single problem at 

a time and it was very difficult to trace and correct the programming error, 

if any. The examples of first generation computers are Universal 

Automatic Computer (UNIVAC) and Electronic Numerical Integrator and 

Computer (ENIAC).  

 

2) Second Generation (1956-1963):  

The second generation of computers was based on the transistors which 

substituted the vacuum tubes. The transistor was superior to the vacuum 

tubes in the sense it made computers smaller, faster, cheaper and more 

energy efficient. It didn’t require a complete room anymore. However, 
even though it was a Fundamentals of Computers 8 improvement over 
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the vacuum tubes to the transistor still generated a great deal of heat 

which sometimes subjected the computer to damage its internal sensitive 

parts.  

This generation of computers used assembly language for programming. 

In this period, higher level programming language like Common Business-

oriented Language (COBOL), Formula Translation (FORTRAN), and 

Algorithmic Language (ALGOL), Python, were developed.  

 

3) Third Generation (1964-1971):  

Third generation of computers brought a significant change in the way of 

computing. This generation of computers was based on the use of 

integrated circuits, which drastically increased speed and efficiency of 

computers. As a result, computer became smaller in size as more 

components were squeezed onto the single chip.  

These were the first computers where users interacted using keyboards 

and monitors which are interfaced with an Operating System (OS), a 

consequential leap up from the punch cards and printouts. This facilitates 

these machines to run various applications at once utilizing a central 

program which functioned to monitor memory. Examples of this 

generation of computers are IBM-360 and CDC-6400.  
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4) Fourth Generation (1972-2010): 

The fourth generation of computers was based on the use of 

microprocessors, a single silicon chip on which thousands of integrated 

circuits were built. The use of microprocessors considerably reduced the 

size of computers now they can even be fit in the palm of hand. The 

personal computers and laptop all made use of microprocessors. For the 

first time in 1981, IBM introduced computers for the home users and in 

1984, Macintosh was introduced by Apple. Fourth generation computers 

could be link together to form a network which eventually led to the 

expansion, birth and rapid evolution of the Internet. Other primary 

advances during this period have been the Graphical User Interface 

(GUI), the mouse and advances in laptop capability etc.  

 

5) Fifth Generation (2010 -2020): 

The fifth generation of computers began with major innovations in 

computer architecture like- parallel processing, intelligent programming, 

application of artificial intelligence, knowledge-based system etc. The 

essence of fifth generation is to utilize these technologies to ultimately 

engender machines which can proceed and acknowledge natural 

language, and have efficiency to determine and organize them. Movies 

like Terminator series (1, 2 and 3) and robots are based on the concept 

of fifth generation computers. Fifth generation based robots have been 

developed which are enormously being used in medical science and 

research.  
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6) Sixth Generation (2020 onwards):  

The sixth generation of computers is based on the nanotechnology. This 

generation of computers can be defined as the era of intelligent computer, 

based on artificial neural Introduction to Computers 9 networks or 

“artificial brains”. Artificial Intelligence (AI) or artificial brains is a concept 
in programming which enables the devices to think and take actions on 

their own. These computers have the ability to learn via a variety of 

advanced algorithms. The generation also introduced voice recognition, 

which enables the computers to take dictations and recognize words. The 

use of nanotechnology is a characteristic of sixth generation computers. 

 

1.4. Summary 

A Computer is basically a programmable electronic device which accepts 

data, performs operations on the given data and presents the results and 

can also store the data or results as per the requirements. Computers are 

general purpose information machines that can perform a variety of tasks 

on data. 

Let Us Sum Up 

In this unit you have learned the followings: 

 Computer is the main aspect of working for preparing 

documentation using Ms-word, creating excel sheet for using 

some accounts documentation.  

 Computer occupies such an important place in the modern world 

that the creation, storage and reuse of the people and the destiny 

of the country are very much influenced by it.  

Check your Progress 

1.  Computer is basically  ___________ 

2.  The sixth generation of computers is based on the ______________.  

3. Computer is ________________ 
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Glossary 

Computer  :  The combination of hardware and software. 

Operating system:  The kernel of process 

Input:  used to feed the data 

Output:  To display the result or value 

Generation:  Based on the technology development and growth of 

computer versions and operations. 

Answer to Check your Progress 

1. programmable electronic device  

2. nanotechnology  

3. The combination of hardware and software  

Suggested Reading 

1. H N Tiwari and Hem Chand Jain (2020), Computer Applications in 

Business CBCS (Choice Based Credit System), 6th Edition, Taxmann 

Publications. 

2. Dr. Sandeep Srivastava, Dr. Mirza Shab Shah, Er. Meera Goyal (2021), 

Computer Applications in Business (Latest Edition), 1st Edition, SBPD 

Publications. 

3. Er. Meera Goyal, Dr. Sandeep Srivastava(2022), Computer 

Applications in Business, 1st  Edition , SBPD Publications. 

 

  

https://www.flipkart.com/books/er-meera-goyal~contributor/pr?sid=bks
https://www.flipkart.com/books/dr-sandeep-srivastava~contributor/pr?sid=bks
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Unit-2 
Types of Computers  

STRUCTURE  

Overview 

Objectives 

2.1.Types of computer   

2.2.Desk top computer  

2.3.Laptop  

2.4.Summary 

2.5.Keywords 

Let us Sum up 

Check your progress 

Glossary 

Answer to check your process 

Suggested Reading 

Overview  

In this unit the learners will learn and study about the Types of computer,   

Desk top computer and Laptop. 

Objectives  

After completion of this unit, you will be able to: 

 Describe the purpose and scope of Computer speed and size 

 Identify the roles, skills and functions of computer generations 

•  understand the Type of computers;  

•  describe the various types of computers;  

•  explain how computers are useful in various areas;  

•  understand the advantages and disadvantages of computers; and  

•  differentiate computers like laptop and desktop.  

2.1. Type of Computer  

1) Micro Computer:  

Micro computers are the smallest computer system. They are mostly 

single user general purpose computers. They are relatively small in size 

and inexpensive computer with a microprocessor as its CPU. Their speed 

as in comparison to mainframe or supercomputer is low and their size 
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range from calculator to desktop. These computers are mainly used for 

computing purpose and mostly used in educational institutions, home and 

offices. Examples of micro computers are desktop PCs, Laptop, 

notebook, personal digital assistance, smart phones, tablets, smart 

watches etc.  

 

2) Mini Computers:  

Mini computers are larger in size and are suitable for a small business or 

for a department in a large organization to be used as servers which 

support hundreds of users at a time in file sharing, printer sharing and 

storing central information. They were actually designed for control, 

instrumentation, human interaction, and communication switching and 

later they became very popular for personal use with evolution. These 

computers possess greater memory and are capable of handling input 

output devices. Examples of mini computers are Laptop, PC etc.  

 

3) Mainframe Computers:  

Mainframe computers are popularly known as big iron, they are very big 

in size and very expensive. These computers are capable of supporting 

thousands of users at a time and have massive data storage capacity. 

These computers are basically used by big organizations such as banks, 

E-commerce portals, insurance companies, railways, airlines etc. for bulk 
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data processing such as statistics, census data processing, transaction 

processing and are widely used as the servers as these systems has a 

higher processing capability as compared to the other classes of 

computers. 

 

4) Super Computers:  

A super computer is a computer with a high level of performance; they are 

most powerful and very expensive. Super computers are at the apex of 

computing system as they have ability to perform billions of instructions 

per second. Super computers play a very vital role in the field of 

computation, and are utilized for performing intensive computational tasks 

in numerous fields such as quantum mechanics, weather forecasting, 

climate research, oil and gas exploration, molecular modeling, and 

physical simulations etc. These computers are very costly and are treated 

as national resources. Examples of super computers are Parallel 

Machines (PARAM), Jaguar, Roadrunner, etc. On the Basis of Data 

Handling or Technology Used. 

 

1) Analog Computer:  

Analog computer is a type of computer which uses continuously-

changeable aspects of physical fact such as electrical, mechanical, or 

hydraulic quantities to model the problem being solved. Anything that is 

variable with respect to time and continuous can be claimed as analog 
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just like an analog clock measures time by means of the distance travelled 

for the spokes of the clock around the circular dial.  

 

2) Digital Computer:  

Digital computers take input data in form of numbers and perform 

arithmetic and logical operations onto it to get the results. These 

computers are of high speed and very accurate. Digital computers count 

and answer the questions by the answer of how many. It can be used for 

performing mathematical calculations, organizing and analyzing data, 

controlling industrial and other processes, and to simulate dynamic 

systems such as global weather patterns. It gives continuous output but 

users get the output only when the computations are completed. 

Examples of digital computers are desktops, notebooks, work stations, 

smart phones etc.  

 

3) Hybrid Computer:  

A hybrid computer is a digital computer that accepts analog signals, 

converts them to digital and processes them in digital form. These 

computers incorporate the technology of both analog and digital 

computers. These computers store and process analog signals which 

have been converted into discrete numbers. Analog-to-digital converters 

are used to convert analog signals into digital signals. These computers 
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are used in radars. For example, in central national defense and 

passenger flight radar system.  

 

 

2.2. Desk top Computer  

A desktop computer is a computer that fits on or under a desk. They 

utilize peripheral devices for interaction, such as a keyboard and mouse 

for input, and display devices like a monitor, projector, or television. 

Desktop computers can have a horizontal or vertical (tower) form factor, 

or be combined with a monitor to create an All-in-One computer. Unlike 

a laptop, which is portable, desktop computers are generally made to stay 

at one location. 

Below is a picture of the main parts (components) that help make up a 

computer. In the picture, you can see a desktop computer, flat-panel 

display, speakers, keyboard, and mouse. We've also labeled each of 

the input devices and output devices. 

  

2.3 Laptop Computer  

A Laptop computer (also called portable computer  or notebook 

computer   in English) (Other terms, such as ultra-book or note book, refer 

to specific types of laptop) is designed with portability in mind. It was 

developed in the late 1980s. It is briefcase style with a foldout screen with 

https://www.computerhope.com/jargon/c/computer.htm
https://www.computerhope.com/jargon/m/monitor.htm
https://www.computerhope.com/jargon/h/horizont.htm
https://www.computerhope.com/jargon/v/vertical.htm
https://www.computerhope.com/jargon/f/formfact.htm
https://www.computerhope.com/jargon/a/all-in-one-computer.htm
https://www.computerhope.com/jargon/l/laptop.htm
https://www.computerhope.com/jargon/c/component.htm
https://www.computerhope.com/jargon/f/fpdispla.htm
https://www.computerhope.com/jargon/f/fpdispla.htm
https://www.computerhope.com/jargon/s/speaker.htm
https://www.computerhope.com/jargon/k/keyboard.htm
https://www.computerhope.com/jargon/m/mouse.htm
https://www.computerhope.com/jargon/i/inputdev.htm
https://www.computerhope.com/jargon/o/outputde.htm
https://ecomputernotes.com/fundamental/introduction-to-computer/what-is-computer
https://ecomputernotes.com/fundamental/introduction-to-computer/what-is-computer
https://ecomputernotes.com/fundamental/introduction-to-computer/netbook
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a clam shell form factor, suitable for mobile use and with a miniature 

keyboard. It is small enough to use in your lap. The laptop is battery or 

AC-powered personal computer that should be charged via a plug and 

socket, and when it runs out of power, it must be recharged 

regularly.    Laptop computer originally monochrome CRT-based, The 

components of a laptop are built-in monitor; keyboard, touch-pad (which 

replaces the mouse), USB, graphics card and sound cards as well as 

high-capacity batteries that are made to keep the laptop power for a long 

period of time. 

The laptops are more expensive because the technology to be 

more compact and they are more difficult to design and manufacture. If 

you have a limited space, it is worth considering a “portable” computer. 

They give you exactly the same comfort and performance of a desktop 

computer, but they take up less space. 

 

2.4. Summary 

The laptops are more expensive because the technology to be 

more compact and they are more difficult to design and manufacture.  

2.5. Keywords. 

Laptops, Desktops, Portable, Analog and Digital 

Let us Sum Up 

In this unit you have learned the followings: 

 Computer is the main aspect of working for people and different types 

of computer are fixed and portable based on the size and operating 

methods. 

 Computer occupies such an important place in the modern world that 

is divided in various size and operations. Computer is used to  

creation, storage and reuse of the documents and files. 

https://ecomputernotes.com/fundamental/introduction-to-computer/personal-computer
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Check your Progress 

1.  Computer is fixed in one location is called   ___________ 

2.  Laptop is ________ types of computer  

3.  They are ______ types of computer based size 

4.  ____________ is used to store documents. 

Glossary 

Laptop Computer  :  Is a portable device. 

Memory   :  it is used to store data  

Input  :  used to feed the data 

Output  :  To display the result or value 
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Answer to Check your progress 

1.Personal Computer 

2.Handhold 

3.Three 

4.Memory 

Suggested Reading 

1. H N Tiwari and Hem Chand Jain (2020), Computer Applications in 

Business CBCS (Choice Based Credit System), 6th Edition, Taxmann 

Publications. 

2. Dr. Sandeep Srivastava, Dr. Mirza Shab Shah, Er. Meera Goyal (2021), 

Computer Applications in Business (Latest Edition), 1st Edition, SBPD 

Publications. 

3. Er. Meera Goyal, Dr. Sandeep Srivastava(2022), Computer 

Applications in Business, 1st  Edition , SBPD Publications. 

 

  

https://www.flipkart.com/books/er-meera-goyal~contributor/pr?sid=bks
https://www.flipkart.com/books/dr-sandeep-srivastava~contributor/pr?sid=bks
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Unit -3 
Function of Computer 

STRUCTURE 

Overview 

Objectives 

3.1.Computer Devices 

3.2.Functions of Computer 

3.3.Computer functionality  

3.4.Summary 

3.5.Keywords 

3.6.Terminal Questions 

Let us Sum Up  

Check your Progress 

Glossary 

Answer to Check your Progress 

Overview  

In this unit the learners will learn and study about the Computer Devices, 

Functions of computer and the Computer functionality. 

Objectives  

After completion of this unit, you will be able to: 

 Describe the purpose computer devices 

 Identify the roles, skills and functions of computer functionality  

 To clear idea of computer utilizations. 

 To understand the computer functionality and different functions. 

3.1. Computer devices 

Components of a Computer System:  

Hardware & Software Every computer is composed of two basic 

components called, hardware and software. Hardware includes the 

tangible parts of the computer which either can be seen or touched, for 

example, CPU, keyboard, mouse, monitor, LCD screen and printer, 

whereas, the software are the components which activates the physical 

parts. Software consists of features that are responsible for directing the 

tasks to the hardware. Software can be divided into other programs and 

data. As compared to software, hardware is a physical entity. Both 

hardware and software are interconnected, without software, the 
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hardware cannot function. However, without the creation of hardware to 

perform tasks directed by software via the central processing unit, 

software would be useless below mentioned figures can gives a clear 

glimpse about the hardwares.  

 

Fig. : Desktop Vs. Laptop 

A detailed explanation on Hardware and Software is given below:  

Hardware: 

 Hardware is basically the physical element of a computer. It is also called 

as the machinery or the equipment of the computer. However, most of a 

computer's hardware cannot be seen; in other words, it is not an external 

element of the computer. A computer's hardware is consisted of various 

different parts, but the most vital of all these is the motherboard. The 

motherboard is made up of even more parts capable to power and control 

the computer. Hardware is limited to specifically designed tasks that are, 

taken independently, are very simple. On the other hand, Software 

implements algorithms (problem solutions) that allow the computer to 

complete much more complex tasks. 

Software: 

Software is known as programs or apps, comprising of all the instructions 

that direct the hardware in performing tasks. These instructions come from 

a software developer in the form and are accepted by the platform 

(operating system + CPU) that they are based on. Software is capable 

enough to perform numerous tasks, compared to hardware that can only 

perform mechanical tasks they are designed for. Software provides the 

means for accomplishing many different tasks with the same basic 

hardware. 

3.2. Functions of Computer 

The four functions of a computer actually explain the core reasons why it 

was built. They include: 
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 Data input 

 Data processing. 

 Information output. 

 Data and information storage. 

3.3. Computer Functionality 

1. Data Input 

Every computer is designed with data input as a first function, an activity 

which is accomplished via input devices. Data entry is done manually, 

automatically or both. Manual input is done via add-on peripherals like the 

keyboard, mouse and stylus. Input can also be accomplished via vocal 

dictation applications and body gestures peripherals like Kinect and 

biometric devices. Elsewhere, data input is also done using secondary 

storage media and networking interfaces. 

Application software used for this purpose will also dictate what data is 

entered. Word processing software is designed to input basic 

alphanumerical data, while a photo editing application is used to input and 

manipulate images. This data may be entered into a database, 

spreadsheet or other forms of a computerized work area. Automated 

applications and robotics can also be used to intelligently feed data into 

the computer on station or remotely. As an example, tallying of electoral 

process can be accomplished remotely and automatically. 

 

2. Data Processing 

Data processing is the core function of a computer. Processing involves 

manipulation of raw data into before converting it into meaningful 

information. Usually, data is in raw form, and will thus undergo processing 

before dissemination for user consumption. 

The 'brain' of the computer where data is processed is referred to as the 

microprocessor. It is also commonly known as the Central Processing Unit 

(CPU) or Accelerated Processing Unit (APU). 
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The processing chips in modern personal computing devices continue to 

evolve and outperform its predecessors. One particular evolution is the 

merger of microprocessor and graphics processing unit (GPU) into what 

is now known as accelerated processing unit. The merger allows for the 

integration of powerful graphics processing abilities inside the traditional 

arithmetic and logical computations of the processor. 

 

3. Information Output 

When raw data has been manipulated by the microprocessor, the 

outcome is meant to be disseminated for useful purposes. The output is 

thus referred to as information and is beneficial to the computer user. 

Processed data or information can be, 

 viewed as alphanumeric, images and video via a display hardware 

 listened to as audio files by use of a speaker 

 printed as hard copy output onto paper 

 printed as 3D models 

 

 

4. Data and Information Storage 

The fourth and equally very important function of a computer is data and 

information storage. After sleepless nights of video and animation creation 
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and editing, the user wants to have the finished product stored for future 

dissemination and additional editing. 

A computer can store information internally and externally. The hard disk 

drive (HDD) and/or solid-state disk drive (SSD) are internal storage 

devices and serve to protect and house all data and information on a 

computer. In bigger systems, the RAID system is used. Multiple disk 

drives operate simultaneously to ensure data and information integrity. 

External storage is achieved through accessories that attach externally to 

the computer. They include external drives and optical disks. 

3.4. Summary 

A Computer is basically a programmable electronic device which accepts 

data, performs operations on the given data and presents the results and 

can store the data or results as needed. 

3.5. Keywords 

Data, Program, Process, Input and Output 

Let us Sum Up 

In this unit you have learned the followings: 

 Data is interaction between user and computer  

 Program is set of coding or source code that will fulfil the user need 

or user expectation. 

 Input and output are insert data and display a result. 

Check your Progress 

1.  Keyboard is used to   ___________ 

2.  Monitor is  ________  in computer 

3.  The input devices are  ________ 

4.  ____________ is known as output devices. 
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Glossary 

Computer  :  The combination of hardware and software. 

Data :  user interaction to computer based on data. 

Input :  used to feed the data 

Output :  To display the result or value 

Answer to Check your Progress 

1.Input device 

2.Display result  

3.Key Board and Mouse 

4.Printer 

Suggested Reading 

1. H N Tiwari and Hem Chand Jain (2020), Computer Applications in 

Business CBCS (Choice Based Credit System), 6th Edition, Taxmann 

Publications. 

2. Dr. Sandeep Srivastava, Dr. Mirza Shab Shah, Er. Meera Goyal (2021), 

Computer Applications in Business (Latest Edition), 1st Edition, SBPD 

Publications. 

3. Er. Meera Goyal, Dr. Sandeep Srivastava(2022), Computer 

Applications in Business , 1st  Edition , SBPD Publications. 

 

 

  

https://www.flipkart.com/books/er-meera-goyal~contributor/pr?sid=bks
https://www.flipkart.com/books/dr-sandeep-srivastava~contributor/pr?sid=bks
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Unit-4 

Application and Current Trends for Business 
Related Problems  

STURCTURE 

Overview 

Objectives 

4.1. Current systems 

4.2. Business computer  

4.3. Application and current trends for business related problem 

4.4. Summary 

4.5. Terminal Questions 

Let us Sum up 

Check your progress 

Glossary 

Answer to check your progress 

Suggested Reading  

Overview  

In this unit the learners will learn and study about the Current systems , 

Business computer and the Application and current trends for business 

related problems. 

Objectives  

After completion of this unit, you will be able to: 

 Describe the purpose computer devices 

 Identify the roles, skills and functions of computer functionality  

 To clear idea of computer utilizations. 

 To understand the application and current trends for business 

problem 

4.1. Current Systems. 

Bus: A set of wires used to transmit data, addresses, or control signals 

between directly connected components of a computer. They are called 

data, address, and control busses, respectively.  

CPU: Central Processing Unit. The words CPU and processor are used 

interchangeably in this article. Distributed processing: running a single 

program on computers of a network.  
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DRAM: Dynamic RAM. Its contents much be refreshed very often to avoid 

the loss of data. Massively-parallel computer: a parallel computer 

containing hundreds or thousands of (micro) processors.  

 

MIMD: Multiple-Instruction streams, Multiple-Data streams. 

Multicomputer: a parallel computer containing many processors which are 

interconnected via a static point-to-point (i.e., processor-to-processor) 

physical network.  

 

Multiprocessor: a parallel computer containing many processors which 

can exchange information through a shared memory. They access this 

memory via a dynamic network. The exact interconnection scheme is 

determined each time by the application program.  

Parallel computer: a computer that contains many processors.  
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RAM: Random-Access Memory. They can be read and written at run time 

by programs.  

 

ROM: Read-Only Memory. They cannot be written by programs. Their 

contents can be modified only by plugging them into specialized hardware 

programmers.  

 

SIMD: Single-Instruction stream, Multiple-Data streams.  

SRAM: Static RAM that is much faster than DRAM.  

 

Supercomputer: a computer capable of delivering performance many 

orders of magnitude larger than that of any single-processor computer. 

This term is currently associated with massively-parallel computers and 

vector supercomputers.  

System boot up code: The part of the operating system that initializes the 

computer. Tri-state gate: a digital circuit that has three possible output 

states, namely 0, 1, and high-impedance. In the high-impedance state, 

the output is disabled and seems to be "floating" (that is, it does not affect 



31 

 

and is not affected by any other signal applied to the corresponding 

terminal).  

Vector supercomputer: a computer capable of delivering performance for 

array (i.e., vector) operations many orders of magnitude larger than that 

of any conventional computer. It contains specialized parallel units for 

vector operations. 

4.2. Business computer 

The most common type of business computer is a PC (personal 

computer). PCs are made by different companies but all use the same 

underlying technology. They usually run Microsoft Windows and are the 

type of computer most people are familiar with. 

The main alternative is an Apple Mac. Macs are usually more expensive 

than comparable PCs and have traditionally been used in creative 

industries. 

Macs can be popular with employees and some companies use a mix of 

PCs and Macs, depending on staff preferences and roles. 

Business computer systems are available as: 

 Desktops, consisting of a base unit, monitor, keyboard and 

mouse. They are designed to be set up and used in one place. 

 'All-in-ones', as above, but with the monitor also housing the 

computer itself (Apple iMacs are the most common example). 

Again, designed to be set up and used in one place. 

 Laptops, portable computers that can be used on the move. 

Some of the applications of computers in business organizations are 

explained below:  

1) Communication: Computers play a very important role in 

business organisations to maintain a smooth flow of information 

and communication between different parties and stakeholders. 

Business can use various methods of communication such as 

email, live chat tools, video or phone conferencing, social 

networking, web conferencing etc. It saves times and also 

improves the functioning of the organisation. With such advance 

tools, it also becomes easy for the business to offer customer 

support to its clients in a timely and efficient manner.  
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2) Marketing: Organizations can widely use computers for 

marketing as most of the marketing is done online via social 

media, blogging, website development, advertising, e-newsletter 

etc. IT developers can professionally create a website by using 

various enticing graphics and content with different forms of 

media, such as text, images, and videos to make the campaign 

more attractive and lucid for the audience. By using Search Engine 

Optimization (SEO) and Web Analytics, the website would appear 

prominently in Google’s search results, which then attracts traffic 
and ultimately enables the business to sell those products to 

website visitors.  

 

 

 

 

3) Accounting: Computers can also help organizations in sorting 

its large financial data in order to obtain their large and small scale 

financial positions just by few clicks. Computers are also useful for 

performing various tasks like invoicing clients, maintaining data 

about debtors and creditors, calculating payroll, calculating and 

filing tax forms etc. With the computer, accountants can now focus 

on the higher level picture of a business’s finances, leaving the 
lower level stuff to the machines.  
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4) Storage: Businesses can store enormous data on computers. They 

don't need huge cabinets for storing data now. With computers and 

server, organizations are capable of storing and sorting billions of files and 

enable them to access at any time. Digital storage is much larger and 

more efficient and secure while compared with the physical storage, as it 

is more difficult to lose or steal files from a well-protected database which 

is one of the main benefits of the computer.  

5) Educational Purposes: With the access of internet on the computers, 

organizations can reach the pool of world’s information which can be used 

efficiently to educate its employees such as about the company 

Fundamentals of Computers 24 policies, software use, as well as 

standard procedure and safety. Instead of hiring teachers’ employees can 
be educated online. Live webinar, conferences and question and answer 

sessions can also be conducted. Employees can learn through various 

media, such as videos, text, etc. which enables them to better understand 

the subject matter.  

6) Research: Computers make business organisations capable of doing 

a variety of functions, including research about the competition, as well as 

knowing about the taste and preferences of its customers. With modern 

data-mining techniques, a business can acquire insightful information 

about its customers and competition from all kinds of places, including 

forums, search engines, industry-specific websites and even from social 

networks. By conducting online surveys, business can know about the 

public opinions or while launching any new products and public reactions 

can also be known by reviewing customers review on different sites.  

4.3 Application and current trends for business related 

problem 

Business Trends Table of Contents 

1. The On-Demand Economy Shift 

2. Implementation of Contactless Payment Options 

3. Ecommerce Dominance and Social Commerce Growth 

4. Increased Collaboration with Influencers 

https://comparecamp.com/business-trends/#1
https://comparecamp.com/business-trends/#2
https://comparecamp.com/business-trends/#4
https://comparecamp.com/business-trends/#5
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5. Investments in Retail Technology 

6. Remote Work on the Rise 

7. More Smart Offices 

8. Better Focus on Employee Happiness 

9. Improved Personalized Omni channel Experiences 

10. The 5G Network and AI 

4.4 Summary 

Desktop computer systems are sometimes cheaper than a laptop of 

equivalent specification, but laptops offer the added benefit of portability. 

4.5. Keywords 

Bus, RAM, ROM, Business Computer and Business Trends 

4.6 Terminal Questions  

1. What is business system? 

2. What are the use of business system? 

3. Name any five of business system. 

4. Write the use of desktop computer. 

Let us Sum Up 

In this unit you have learned the followings: 

 Creating documents are business system  

 Program is set of coding or source code that will fulfil the user need 

or user expectation. 

 Input and output are insert data and display a result. 

Check your Progress 

1.  The another name of source code is   ___________ 

2.  Program is set of ____________ 

3.  The task to completed is called  ________ 

4.  ____________ is used to construct program. 

  

https://comparecamp.com/business-trends/#6
https://comparecamp.com/business-trends/#7
https://comparecamp.com/business-trends/#8
https://comparecamp.com/business-trends/#9
https://comparecamp.com/business-trends/#10
https://comparecamp.com/business-trends/#11
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Glossary 

Program :  The set of instruction is called program. 

Data :  used to construct program  

Input :  used to raw material 

Output :  To display the result or value 

Answer to Check your Progress 

1.Program 

2,Instruction 

3.Process 

4.Software 

Suggested Reading 

1. H N Tiwari and Hem Chand Jain (2020), Computer Applications in 

Business CBCS (Choice Based Credit System), 6th Edition, Taxmann 

Publications. 

2. Dr. Sandeep Srivastava, Dr. Mirza Shab Shah, Er. Meera Goyal (2021), 

Computer Applications in Business (Latest Edition), 1st Edition, SBPD 

Publications. 

3. Er. Meera Goyal, Dr. Sandeep Srivastava(2022), Computer 

Applications in Business, 1st  Edition , SBPD Publications. 

  

https://www.flipkart.com/books/er-meera-goyal~contributor/pr?sid=bks
https://www.flipkart.com/books/dr-sandeep-srivastava~contributor/pr?sid=bks
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Block-2:  Introduction  

Block-2: Hardware and Software has been divided into four Units (Unit-

5 to Unit-8). 

Unit-5: Hardware system deals with Introduction to Hardware, Hardware 

systems and the Types of Hardware. 

Unit-6: Input, storage and output devices explains about Input and 

output devices, Storage devices, Internal and External parts of Hardware 

and software. 

Unit-7: System software: Operating system describes about System 

software, Introduction to Operating systems, Types of operating systems 

Unit-8: Application Software presents about Introduction to software, 

Application software and Definition of Internet 

In all the units of Block -2: Hardware and Software, the Check your 

progress, Glossary, Answers to Check your progress and Suggested 

Reading has been provided and the Learners are expected to attempt all 

the Check your progress as part of study.  
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Unit-5 
 Hardware System Types 

STURCTURE 

Overview 

Objectives 

5.1. Introduction to Hardware 

5.2. Hardware systems 

5.3. Types of Hardware 

5.4. Summary 

5.5. Keywords 

Terminal Questions 

Let us Sum up 

Check your progress 

Glossary 

Answer to check your progress 

Suggested Reading 

Overview  

In this unit the learners will learn and study about the basic Introduction 

to Hardware, the  Hardware systems and Types of Hardware. 

5.0 Objectives  

After Complication of this unit you will able; 

 To understand the hardware system 

 To learn about type of hardware and uses 

5.1. Introduction to Hardware 

Hardware is basically the physical element of a computer. It is also called 

as the machinery or the equipment of the computer. However, most of a 

computer's hardware cannot be seen; in other words, it is not an external 

element of the computer. A computer's hardware is consisted of various 

different parts, but the most vital of all these is the motherboard. The 

motherboard is made up of even more parts capable to power and control 

the computer. Hardware is limited to specifically designed tasks that are, 

taken independently, are very simple. On the other hand, Software 

implements algorithms (problem solutions) that allow the computer to 

complete much more complex tasks. 
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5.2. Hardware systems 

System hardware is a general term for various physical components of a 

computer system. It includes all the parts inside the computer case such 

as the CPU, hard disk drive, graphic cards, sound cards, RAM, power 

supply unit, motherboard, etc. Computer hardware is what you can 

physically touch. 

Those who work in related fields use a strong knowledge of current and 

emerging devices, circuits, algorithms, compilers, and applications to 

build hardware components (e.g., microprocessors, GPUs, memories, 

ASICs, FPGAs). Then, they integrate them into systems that meet needs 

at an acceptable cost. Professionals in this area also develop tools and 

techniques for automating and testing the design and integration of 

hardware. 

 

5.3. Types of Hardware 

 RAM. RAM (Random Access Memory) is a type of computer 

hardware that is used to store the information and then process 

that information. ... 

 Hard disk. The hard disk is another type of computer hardware that 

is used to store the data in it. ... 

 Monitor. ... 

 CPU. ... 

 Mouse. ... 

 Keyboard. ... 

 Printer. 
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Hardware Components 

Introduction 

Hardware is the most visible part of any information system: the 

equipment such as computers, scanners and printers that is used to 

capture data, transform it and present it to the user as output. Although 

we will focus mainly on the Personal Computer (PC) and the peripheral 

devices that are commonly used with it, the same principles apply to the 

complete range of computers: 

 

 Supercomputers, a term used to denote the fastest computing 

engines available at any given time, which are used for running 

exceptionally demanding scientific applications. 

 Mainframe computers, which provide high-capacity processing 

and data storage facilities to hundreds or even thousands of users 

operating from (dumb) terminals. 

 Servers, which have large data storage capacities enabling users 

to share files and application software, although processing will 

typically occur on the user’s own machine. 

 Workstations, which provide high-level performance for individual 

users in computationally intensive fields such as engineering. 

 Personal computers (including laptop/notebook computers) have 

a connected monitor, keyboard and CPU, and have developed 

into a convenient and flexible business tool capable of operating 

independently or as part of an organizational network. 

 Mobile devices such as personal digital assistants or the latest 

generation of cellular telephones, offer maximum portability plus 

wireless connection to the internet, although they do not offer the 

full functionality of a PC. 

https://s3-us-west-2.amazonaws.com/courses-images-archive-read-only/wp-content/uploads/sites/746/2015/08/23081927/120643390_00c2dafd3d_o-1.jpg
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And we are already moving into the age of wearable computers for 

medical or security applications, embedded computers in appliances 

ranging from motor cars to washing machines, and the smart card which 

will provide identification, banking facilities, medical records and more! 

Hardware - Input devices 

Data may enter an information system in a variety of different ways, and 

the input device that is most appropriate will usually depend on the type 

of data being entered into the system, how frequently this is done, and 

who is responsible for the activity. For example, it would be more 

efficient to scan a page of typed text into an information system rather 

than retyping it, but if this happens very seldom, and if typing staff are 

readily available, then the cost of the scanner might not be justified. 

However, all of the input devices described in this chapter have at least 

one thing in common: the ability to translate non-digital data types such 

as text, sound or graphics into digital (i.e. binary) format for processing 

by a computer. 

The keyboard 

A lot of input still happens by means of a keyboard. Usually, the 

information that is entered by means of a keyboard is displayed on the 

monitor. The layout of most keyboards is similar to that of the original 

typewriter on which it was modelled. Ironically, this “QWERTY” keyboard 
layout was originally designed to slow the operator down, so that the 

keys of the typewriter would not get stuck against each other. This layout 

now works counter-productively since a computer can process keyboard 

input many times faster than even the fastest typist can manage.  

 

A number of attempts have been made to design alternative layouts by 

rearranging the keys (the Dvorak keyboard) or by reducing the number 

of keys. None of these alternative designs has really caught on. Special 

keyboards have also been designed for countries that use a non-Roman 

alphabet, and also for disabled people. 
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Pointing devices 

 

The now ubiquitous electronic mouse is an essential input device for use 

with any graphical user interface. It consists of a plastic moulded 

housing, designed to fit snugly in the palm of the hand, with a small ball 

at its bottom. Moving the mouse across a flat surface will translate the 

movements into a rolling action of the ball. This is translated into 

electronic signals that direct the corresponding movement of a cursor on 

the computer monitor. Buttons on the mouse can then be used to select 

icons or menu items, or the cursor can be used to trace drawings on the 

screen. 

The less popular trackball operates exactly like an “upside-down” mouse 
except that the ball is much larger and, instead of the mouse being 

moved over a surface, the user manipulates the ball directly. Since the 

trackball can be built into the side of the keyboard, it obviates the need 

for a free surface area and is therefore handy in situations where 

desktop surface area is at a premium or not available. Originally popular 

in educational laboratory settings and for laptop computers, trackballs 

are now mainly confined to exhibition displays and other public 

terminals. 

 

Touch-screens are computer monitors that incorporate sensors on the 

screen panel itself or its sides. The user can indicate or select an area 

or location on the screen by pressing a finger onto the monitor. Light and 

touch pens work on a similar principle, except that a stylus is used, 

allowing for much finer control. Touch pens are more commonly used 

with handheld computers such as personal organizers or digital 

assistants. They have a pen-based interface whereby a stylus (a pen 

without ink) is used on the small touch-sensitive screen of the handheld 

https://s3-us-west-2.amazonaws.com/courses-images-archive-read-only/wp-content/uploads/sites/746/2015/08/23082114/mouse-160032_1280.png
https://s3-us-west-2.amazonaws.com/courses-images-archive-read-only/wp-content/uploads/sites/746/2015/08/23082117/mobile-phone-630412_1280.jpg
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computer, mainly by means of ticking off pre-defined options, although 

the fancier models support data entry either by means of a stylized 

alphabet, which resembles a type of shorthand, or some other more 

sophisticated handwriting recognition interface. 

Digitizer tablets also use a pressure sensitive area with a stylus. This 

can be used to trace drawings. A similar conceptual approach is used 

for the touch pad that can be found on the majority of new notebook 

computers, replacing the more awkward joystick or trackball. The user 

controls the cursor by moving a finger across a fairly small rectangular 

touch-sensitive area below the keyboard, usually about 5 cm by 7 cm. 

 

Optical scanners and readers 

There are a number of different optical scanner technologies on the 

market. 

 Optical Scanners use light-emitting devices to illuminate the 

printing on paper. Depending on how much light is reflected, a 

light-sensor determines the position and darkness (or color) of the 

markings on the paper. Special-purpose optical scanners are in 

use by postal services to read and / interpret hand-written postal 

codes. General-purpose scanners are used with personal 

computers to scan in images or text. These vary from handheld 

devices (see picture) to flatbed scanners which feed input 

documents one sheet at a time. A common use of optical scanners 

is the scanning of black-and-white or color images and pictures. 

When scanning text, it is necessary to load additional optical 

character recognition (OCR) software that converts the scanned 

raster-image of the text into the equivalent character symbols, so 

that they can be edited using word processing software. 

 



43 

 

 

 Barcode scanners detect sequences of vertical lines of different 

widths, the ubiquitous barcode as found also on the back of this 

book. These scanners have become very popular with retailers 

due to the fact that all pre-packaged products are now required to 

have a product bar code on their packaging, following the standard 

laid down by the South African Article Numbering Association 

(SAANA). Libraries and video shops now also commonly use bar 

code scanners. They are more generally used for tracking and 

routing large numbers of physical items such as for asset inventory 

purposes in many larger organizations, postal items by the postal 

services and courier services, or for luggage handling by airlines. 

 

 Optical mark readers are capable of reading dark marks on 

specially designed forms. The red multiple choice answer sheets 

in use at many educational and testing institutions are a good 

example. 

 

https://s3-us-west-2.amazonaws.com/courses-images-archive-read-only/wp-content/uploads/sites/746/2015/08/23082119/bar-code-scanner-155766_1280.png
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Other input devices 

A magnetic card reader reads the magnetized stripe on the back of 

plastic credit-card size cards. These cards need to be pre-recorded 

following certain standards. Although the cards can hold only a tiny 

amount of information, they are very popular for access (door) control 

and financial transactions (ATMs and point-of-sale terminals). 

Magnetic ink character recognition (MICR) uses a special ink (containing 

magnetizable elements) and a distinct font type. It is used mainly in the 

banking sector for the processing of cheques. 

 

Touch-tone devices can use a voice telephone to contact computer-

based switchboards or enter information directly into remote computers. 

Many corporate telephone help-lines rely on the customer pressing the 

touch-tone telephone buttons to route his/her call to the correct operator 

by selecting through a menu of possible options. South African banks 

also enable their clients to perform a number of banking transactions via 

telephone. 

 

Digital cameras allow you to make pictures of physical objects directly in 

a digital, i.e. computer-readable, format. Relatively low-cost digital still 

picture cameras are now available that capture images directly on 

electronic disk or RAM media instead of the traditional film. Apart from 

being very compact, most of these digital cameras can also interface 
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directly with personal computers and are thus becoming a popular tool 

to capture pictures for e-mailing or loading on the world-wide Web. 

 

Biometric devices are used to verify personal identity based on 

fingerprints, iris or retinal scanning, hand geometry, facial characteristics 

etc. A scanning device is used to capture key measurements and 

compare them against a database of previously stored information. This 

type of authentication is becoming increasingly important in the control 

of physical access. 

 

Finally, voice input devices are coming of age. Voice-recognition has 

recently made a strong entry into the market with the availability of low-

cost systems that work surprisingly well with today’s personal 

computers. These systems allow for voice control of most standard 

applications (including the operating system). With voice control, the 

computer recognizes a very limited number (50 or less) of frequently 

used, programmable system commands (“save”, “exit”, “print”…) from a 
variety of users. In fact, these systems are not only used for the interface 

of computer programs; they are also slowly making an appearance in 

consumer appliances, novelty items and even motor cars. 

 



46 

 

 

Much more difficult to achieve than voice control, is true voice dictation 

used to dictate e.g. a letter to your word processor. The difficulty is that 

the computer must not only distinguish between many tens of thousands 

of possible words, but it must also recognize the almost unnoticeable 

breaks in between words, different accents and intonations. Therefore, 

voice dictation typically requires a user to train the voice recognition 

software by reading standard texts aloud. Nevertheless, for personal 

purposes and slow typists, voice recognition is rapidly becoming a viable 

alternative to the keyboard. 

5.4 .Summary 

System hardware is a general term for various physical components of a 

computer system.  

It includes all the parts inside the computer case such as the CPU, hard 

disk drive, graphic cards, sound cards, RAM, power supply unit, 

motherboard, etc. 

5.5. Keywords 

Hardware, Software, CPU, General and systems. 

5.6 Terminal Questions  

1. Write the use of hardware device. 

2. Write any five hardware device. 

3. Difference between hardware and software. 

Let us Sum Up 

In this unit you have learned the followings: 

 Creating documents are business system  

 Program is set of coding or source code that will fulfil the user need 

or user expectation. 

 Input and output are insert data and display a result. 
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Check your Progress 

1.  The software means   ___________ 

2.  Hardware example are  ____________ 

3.  Write some name of software  ________ 

4.  Printer is ___________ device. 

Glossary 

Software :  The set of program execution to complete task 

Hardware :  Hard metals and devices are hardware 

Program :  The set of instruction is called program. 

Data :  used to construct program  

Answer to Check your Progress 

1. Execute the program 

2. CPU and Monitor 

3. C,C++ 

4. Output 

Suggested Reading 

1. H N Tiwari and Hem Chand Jain (2020), Computer Applications in 

Business CBCS (Choice Based Credit System), 6th Edition, Taxmann 

Publications. 

2. Dr. Sandeep Srivastava, Dr. Mirza Shab Shah, Er. Meera Goyal (2021), 

Computer Applications in Business (Latest Edition), 1st Edition, SBPD 

Publications. 

3. Er. Meera Goyal , Dr. Sandeep Srivastava(2022), Computer 

Applications in Business 1st  Edition , SBPD Publications. 

  

https://www.flipkart.com/books/er-meera-goyal~contributor/pr?sid=bks
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Unit-6 
Input, Storage and Output Devices  

STURCTURE 

Overview 

Objectives 

6.1.Input and output devices 

6.2.Storage devices 

6.3.Internal & External parts of Hardware and software 

6.4.Summary  

6.5.Keywords 

6.6.Terminal Questions 

Let us Sum up 

Check your progress 

Glossary 

Answer to check your progress 

Suggested Reading 

Overview  

In this unit the learners will learn and study about the Input and output 

devices Storage devices and Internal & External parts of Hardware and 

software. 

Objectives  

After completion of this unit, you will be able to: 

 Describe the purpose computer devices 

 Identify the roles, skills and functions of computer functionality  

 To clear idea of computer utilizations 

 To understand input output devices 

 To understand storage devices and types 

 To learn about Internal and external parts of hardware and 

software  

6.1. Input and output devices 

Input devices: 

There are various input devices available like Microphone, Joystick, 

Keyboard, Pointing device, Image Scanner, Graphics tablet, and more. 
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1. Keyboard 

 A simple device comprising keys and each key denotes either 

an alphabet, number or number commands which can be 

given to a computer for various actions to be performed 

 It has a modified version of typewriter keys 

 The keyboard is an essential input device and computer and 

laptops both use keyboards to give commands to the computer 

2. Mouse 

 It is also known as a pointing device 

 Using mouse we can directly click on the various icons present 

on the system and open up various files and programs 

 A mouse comprises 3 buttons on the top and one trackball at 

the bottom which helps in selecting and moving the mouse 

around, respectively 

 In case of laptops, the touchpad is given as a replacement of 

the mouse which helps in the movement of the mouse pointer 

3. Joy Stick 

 It is a device which comprises a stick which is attached at an 

angle to the base so that it can be moved and controlled 

 Mostly used to control the movement in video games 

 Apart from a computer system, a joystick is also used in the 

cockpit of an aeroplane, wheelchairs, cranes, trucks, etc. to 

operate them well 

 

4. Light Pen 

 It is a wand-like looking device which can directly be moved 

over the device’s screen 

 It is light-sensitive 

 Used in conjunction with computer’s cathode ray tube 
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5. Microphone 

 Using a microphone, sound can be stored in a device in its 

digital form 

 It converts sound into an electrical signal 

 To record or reproduce a sound created using a microphone, 

it needs to be connected with an amplifier 

 

6. Scanner 

 This device can scan images or text and convert it into a digital 

signal 

 When we place any piece of a document on a scanner, it 

converts it into a digital signal and displays it on the computer 

screen 

 

7. Barcode Reader 

 It is a kind of an optical scanner 

 It can read bar codes 

 A source of light is passed through a bar code, and its aspects 

and details are displayed on the screen 
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Output devices: 

There are several output devices available such as Speakers, Printers, 

Plotters, Projector, Monitor and more. 

1. Monitor 

 The device which displays all the icons, text, images, etc. over 

a screen is called the Monitor 

 When we ask the computer to perform an action, the result of 

that action is displayed on the monitor 

 Various types of monitors have also been developed over the 

years 

 

2. Printer 

 A device which makes a copy of the pictorial or textual content, 

usually over a paper is called a printer 

 For example, an author types the entire book on his/her 

computer and later gets a print out of it, which is in the form of 

paper and is later published 

 Multiple types of printers are also available in the market, 

which can serve different purposes 

 

3. Speakers 

 A device through which we can listen to a sound as an 

outcome of what we command a computer to do is called a 

speaker 
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 Speakers are attached with a computer system and also are a 

hardware device which can be attached separately 

 With the advancement in technology, speakers are now 

available which are wireless and can be connected using 

BlueTooth or other applications 

 

4. Projector 

 An optical device which presents an image or moving images 

onto a projection screen is called a projector 

 Most commonly these projectors are used in auditoriums and 

movie theatres for the display of the videos or lighting 

 If a projector is connected to a computer, then the image/video 

displayed on the screen is the same as the one displayed on 

the computer screen 

 

5. Headphones 

 They perform the same function as a speaker, the only 

difference is the frequency of sound 

 Using speakers, the sound can be heard over a larger area 

and using headphones, the sound is only audible to the person 

using them 

 Also known as earphones or headset 
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6.2. Storage devices 

A storage unit is a part of the computer system which is employed to store 

the information and instructions to be processed. A storage device is an 

integral part of the computer hardware which stores information/data to 

process the result of any computational work.  

Without a storage device, a computer would not be able to run or even 

boot up. Or in other words, we can say that a storage device is hardware 

that is used for storing, porting, or extracting data files. It can also store 

information/data both temporarily and permanently. Computer storage is 

of two types:  

 Primary Storage Devices: It is also known as internal memory and 

main memory. This is a section of the CPU that holds program 

instructions, input data, and inter mediate results. It is generally 

smaller in size. RAM (Random Access Memory) and ROM (Read 

Only Memory) are examples of primary storage. 

 Secondary Storage Devices: Secondary storage is a memory that 

is stored external to the computer.  It is mainly used for the 

permanent and long-term storage of programs and data. Hard 

Disk, CD, DVD, Pen/Flash drive, SSD, etc, are examples of 

secondary storage. 

Main Memory 

The function of main memory (also referred to as primary memory, 

main storage or internal storage) is to provide temporary storage for 

instructions and data during the execution of a program.  

Main memory is usually known as RAM, which stands for Random 

Access Memory. Although microchip-based memory is virtually the only 

technology used by today’s computers, there exist many different types 
of memory chips. 
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Random Access Memory (RAM) 

 

RAM consists of standard circuit-inscribed silicon microchips that 

contain many millions of tiny transistors. Very much like the CPU chips, 

their technology follows to the so-called law of Moore, which states that 

they double in capacity or power (for the same price) every 18 months. 

A RAM chip easily holds hundreds of Megabytes (million characters). 

They are frequently pre-soldered in sets on tiny memory circuit boards 

called SIMMS (Single In-line Memory Modules) or DIMMS (Dual …) 
which slot directly onto the motherboard: the main circuit board that 

holds the CPU and other essential electronic elements. The biggest 

disadvantage of RAM is that its contents are lost whenever the power is 

switched off. 

There are many special types of RAM and new acronyms such as EDO 

RAM, VRAM etc. are being created almost on a monthly basis. Two 

important types of RAM are: 

 Cache memory is ultra-fast memory that operates at the speed of 

the CPU. Access to normal RAM is usually slower than the actual 

operating speed of the CPU. To avoid slowing the CPU down, 

computers usually incorporate some more expensive, faster cache 

RAM that sits in between the CPU and RAM. This cache holds the 

data and programs that are needed immediately by the CPU. 

Although today’s CPUs already incorporate an amount of cache 
on the circuit itself, this on-chip cache is usually supplemented by 

an additional, larger, cache on the motherboard. 

 Flash RAM or flash memory consists of special RAM chips on a 

separate circuit board within a tiny casing. It fits into custom ports 

on many notebooks, hand-held computers and digital cameras. 

Unlike normal RAM, flash memory is non-volatile i.e. it holds it 

contents even without external power, so it is also useful as a 

secondary storage device. 

Read-Only Memory (ROM) 

A small but essential element of any computer, ROM also consists of 

electronic memory microchips but, unlike RAM, it does not lose its 

https://s3-us-west-2.amazonaws.com/courses-images-archive-read-only/wp-content/uploads/sites/746/2015/08/23082128/ram-683250_1280.png
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contents when the power is switched off. Its function is also very different 

from that of RAM. Since it is difficult or impossible to change the contents 

of ROM, it is typically used to hold program instructions that are unlikely 

to change during the lifetime of the computer. The main application of 

ROM is to store the so-called boot program: the instructions that the 

computer must follow just after it has been switched on to perform a self-

diagnosis and then tell it how load the operating system from secondary 

storage. ROM chips are also found in many devices which contain 

programs that are unlikely to change over a significant period of time, such 

as telephone switch boards, video recorders or pocket calculators. Just 

like RAM, ROM comes in a number of different forms: 

 PROM (Programmable Read-Only Memory) is initially empty and 

can be custom-programmed once only using special equipment. 

Loading or programming the contents of ROM is called burning the 

chip since it is the electronic equivalent of blowing tiny transistor 

fuses within the chip. Once programmed, ordinary PROMs cannot 

be modified afterwards. 

 EPROM (Erasable Programmable Read-Only Memory) is like 

PROM but, by using special equipment such as an ultra-violet light 

gun, the memory contents can be erased so that the EPROM can 

be re-programmed. 

 EEPROM (Electrically Erasable Programmable Read-Only 

Memory) is similar to EPROM but it can be re-programmed using 

special electronic pulses rather than ultraviolet light so no special 

equipment is required. 

Secondary Storage Devices 

Since the main memory of a computer has a limited capacity, it is 

necessary to retain data in secondary storage between different 

processing cycles. This is the medium used to store the program 

instructions as well as the data required for future processing. Most 

secondary storage devices in use today are based on magnetic or optical 

technologies. 

Disk drives 

The disk drive is the most popular secondary storage device, and is found 

in both mainframe and microcomputer environments. The central 

mechanism of the disk drive is a flat disk, coated with a magnetizable 

substance. As this disk rotates, information can be read from or written to 

it by means of a head. The head is fixed on an arm and can move across 

the radius of the disk. Each position of the arm corresponds to a “track” 
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on the disk, which can be visualized as one concentric circle of magnetic 

data. The data on a track is read sequentially as the disk spins underneath 

the head. There are quite a few different types of disk drives. 

In Winchester hard drives, the disk, access arm and read/write heads are 

combined in one single sealed module. This unit is not normally 

removable, though there are some models available where the unit as a 

whole can be swapped in and out of a specially designed drive bay. Since 

the drives are not handled physically, they are less likely to be 

contaminated by dust and therefore much more reliable. Mass production 

and technology advances have brought dramatic improvements in the 

storage capacity with Terabyte hard drives being state of the art at the 

end of 2006. Current disk storage costs as little Rl per gigabyte. 

Large organizations such as banks, telcos and life insurance companies, 

require huge amounts of storage space, often in the order of many 

terabytes (one terabyte is one million megabytes or a trillion characters). 

This was typically provided by a roomful of large, high-capacity hard drive 

units. Currently, they are being replaced increasingly by redundant arrays 

of independent disks (RAIDs).  

A RAID consists of an independently powered cabinet that contains a 

number (10 to 100) of microcomputer Winchester-type drives but 

functions as one single secondary storage unit. The advantage of the 

RAID is its high-speed access and relatively low cost. In addition, a RAID 

provides extra data security by means of its fault-tolerant design whereby 

critical data is mirrored (stored twice on different drives) thus providing 

physical data redundancy. Should a mirrored drive fail, the other drive 

steps in automatically as a backup. 

 

A low-cost, low-capacity version of the hard disk was popularized by the 

microcomputer. The diskette consists of a flexible, magnetic ti^J surface 

coated mylar disk inside a thin, non-removable, plastic sleeve. The early 

versions of the diskette were fairly large (8″ or 5W) and had a flexible 
sleeve, hence the name floppy diskette.  

https://s3-us-west-2.amazonaws.com/courses-images-archive-read-only/wp-content/uploads/sites/746/2015/08/23082121/floppy-disk-214975_1280.jpg
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These have rapidly been replaced by a diskette version in a sturdier 

sleeve, the stiffy disk, that despite its smaller size (3 W’) can hold more 
data. Although the popular IBM format only holds 1,44 megabytes, a 

number of manufacturers have developed diskette drives that can store 

from 100 to 250 megabytes per stiffy. An alternative development is the 

removable disk cartridge, which is similar in structure to an internal hard 

drive but provides portability, making it useful for backup purposes. 

Magnetic tape 

While disk and optical storage have overtaken magnetic tape as the 

most popular method of storing data in a computer, tape is still used 

occasionally – in particular for keeping archive copies of important files. 

 

The main drawback of magnetic tape is that it is not very efficient for 

accessing data in any way other than strictly sequential order. As an 

illustration, compare a CD player (which can skip to any track almost 

instantly) with a music tape recorder (which has to wind the tape all the 

way through if one wants to listen to a song near the end). In computer 

terms, the ability to access any record, track, or even part within a song 

directly is called the direct access method. In the case of the tape recorder 

one may have to wind laboriously through the tape until one reaches the 

song required – this is referred to as the sequential access method. 

The high-density diskette and recordable optical disk have all but eroded 

the marginal cost advantage that tape storage enjoyed. This technology 

is therefore disappearing fast. 

Optical disk storage 

Optical disks, on the other hand, are rapidly becoming the storage 

medium of choice for the mass distribution of data/programs and the 

backup of data. Similar to disk storage, information is stored and read 

from a circular disk. However, instead of a magnetic read head, a tiny 

laser beam is used to detect microscopic pits burnt onto a plastic disk 

coated with reflective material. The pits determine whether most of the 

laser light is reflected back or scattered, thus making for a binary “on” or 
“off”. In contrast to hard disks, data is not stored in concentric cylinders 
but in one long continuous spiral track. 

https://s3-us-west-2.amazonaws.com/courses-images-archive-read-only/wp-content/uploads/sites/746/2015/08/23082124/vhs-398740_1280.jpg
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Trivial fact: The spiral track used to store data on a CD is over six 

kilometers long. 

A popular optical disk format is the 12-cm CD-ROM. The widespread use 

of music compact discs has made the technology very pervasive and 

cheap. Production costs for a CD-ROM are less than Rl, even for relatively 

small production volumes. The drive reader units themselves have also 

dropped in price and are now hardly more than the cost of a diskette drive. 

A standard CD-ROM can store 650 megabytes of data and the data can 

be transferred at many megabytes per second, though accessing non-

sequential data takes much longer. 

The CD-ROM is a read-only medium. Data cannot be recorded onto the 

disk. The low cost and relatively large capacity makes the CD-ROM ideally 

suited to the distribution of software. They are also ideal for the low-cost 

distribution of large quantities of information such as product catalogues, 

reference materials, conference proceedings, databases, etc. It is 

indispensable for the storage of multimedia where traditional textual 

information is supplemented with sound, music, voice, pictures, 

animation, and even video clips. 

The limitation of the read-only format lead to the development of low-cost 

recordable optical disks. The compact disk recordable (CD-R) is a write-

once, read-many (WORM) technology. The CD-R drive unit takes a blank 

optical disk and burns data onto it using a higher-powered laser. This disk 

can then be read and distributed as an ordinary CD-ROM, with the 

advantage that the data is non-volatile i.e. permanent. The rapid drop in 

the cost of drive units and blank recording media (less than R2 per CD-R) 

is making this a very competitive technology for data backup and small-

scale data distribution. 

Although the 650 megabytes initially seemed almost limitless, many 

multimedia and video applications now require more storage. A new 

format, the Digital Video Data (DVD) standard increased the capacity of 

the CD-ROM by providing high-density, double-sided and double-layered 

CDs. By combining the increased storage capacity with sophisticated data 

compression algorithms, a DVD disc can easily store 10 times as much 

as a CD, sufficient for a full-length high-quality digital motion picture with 

many simultaneous sound tracks. 

Even the DVD is not sufficient storage capacity and currently two optical 

technologies have been developed to increase storage capacity even 

further. The basic specification of both HD-DVD and Blu-Ray provide for 

more than 25 GB of storage on a disc although multi-layer Blu-Ray discs 

with capacities of more than 200 GB have already been developed. 
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Storage Devices 

Now we will discuss different types of storage devices available in the 

market. These storage devices have their own specification and use. 

Some of the commonly used storage devices are: 

1. Primary storage devices 

(i) RAM: It stands for Random Access Memory. It is used to store 

information that is used immediately or we can say that it is a temporary 

memory. Computers bring the software installed on a hard disk to RAM to 

process it and to be used by the user. Once, the computer is turned off, 

the data is deleted. With the help of RAM, computers can perform multiple 

tasks like loading applications, browsing the web, editing a spreadsheet, 

experiencing the newest game, etc. It allows you to modify quickly among 

these tasks, remembering where you’re in one task once you switch to a 
different task. It is also used to load and run applications, like your 

spreadsheet program, answer commands, like all edits you made within 

the spreadsheet, or toggle between multiple programs, like once you left 

the spreadsheet to see the email. Memory is nearly always being actively 

employed by your computer. It ranges from 1GB – 32GB/64GB depending 

upon the specifications. There are different types of RAM, although they 

all serve the same purpose, the most common ones are :  

 SRAM: It stands for Static Random Access Memory. It consists of 

circuits that retain stored information as long as the power is 

supply is on. It is also known as volatile memory. It is used to build 

Cache memory. The access time of SRAM is lower and it is much 

faster as compared to DRAM but in terms of cost, it is costly as 

compared to DRAM. 

 DRAM: It stands for Dynamic Random Access Memory. It is used 

to stores binary bits in the form of electrical charges that are 

applied to capacitors. The access time of DRAM is slower as 

compare to SRAM but it is cheaper than SRAM and has a high 

packaging density. 

 SDRAM: It stands for Synchronous Dynamic Random Access 

Memory. It is faster than DRAM. It is widely used in computers and 

others. After SDRAM was introduced, the upgraded version of 

double data rate RAM, i.e., DDR1, DDR2, DDR3, and DDR4 was 

entered into the market and widely used in home/office desktops 

and laptops. 

(ii) ROM: It stands for Read-Only Memory. The data written or stored in 

these devices are non-volatile, i.e, once the data is stored in the memory 
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cannot be modified or deleted. The memory from which will only read but 

cannot write it. This type of memory is non-volatile. The information is 

stored permanently during manufacture only once. ROM stores 

instructions that are used to start a computer. This operation is referred to 

as bootstrap. It is also used in other electronic items like washers and 

microwaves. ROM chips can only store few megabytes (MB) of data, 

which ranges between 4 and 8 MB per ROM chip. There are two types of 

ROM:  

 PROM: PROM is Programmable Read-Only Memory. These are 

ROMs that can be programmed. A special PROM programmer is 

employed to enter the program on the PROM. Once the chip has 

been programmed, information on the PROM can’t be altered. 
PROM is non-volatile, that is data is not lost when power is 

switched off. 

 EPROM: Another sort of memory is that the Erasable 

Programmable Read-Only Memory. It is possible to erase the info 

which has been previously stored on an EPROM and write new 

data onto the chip. 

2. Magnetic Storage Devices 

(i) Floppy Disk: It is also known as a floppy diskette. It is generally used 

on a personal computer to store data externally. A Floppy disk is made up 

of a plastic cartridge and secures with a protective case. Nowadays floppy 

disk is replaced by new and effective storage devices like USB, etc. 

 

(ii) Hard Disk: It is a storage device (HDD) that stores and retrieves data 

using magnetic storage. It is a non-volatile storage device that can be 

modified or deleted n number of times without any problem. Most of the 

computers and laptops have HDDs as their secondary storage device. It 

is actually a set of stacked disks, just like phonograph records. In every 

hard disk, the data is recorded electromagnetically in the concentric 

circles or we can say track present on the hard disk, and with the help of 

a head just like a phonograph arm(but fixed in a position) to read the 
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information present on the track. The read-write speed of HDDs is not so 

fast but decent. It ranges from a few GBs to a few and more TB. 

 

(iii) Magnetic Card: It is a card in which data is stored by modifying or 

rearranging the magnetism of tiny iron-based magnetic particles present 

on the band of the card. It is also known as a swipe card. It is used like a 

passcode(to enter into house or hotel room), credit card, identity card, 

etc.  

(iv) Tape Cassette: It is also known as a music cassette. It is a rectangular 

flat container in which the data is stored in an analog magnetic tape. It is 

generally used to store audio recordings.  

 

(v) Super Disk: It is also called LS-240 and LS-120. It is introduced by 

Imation corporation and it is popular with OEM computers. It can store 

data up to 240 MB.  

3. Flash memory Devices 

It is a cheaper and portable storage device. It is the most commonly used 

device to store data because is more reliable and efficient as compare to 

other storage devices. Some of the commonly used flash memory devices 

are: 

(i) Pen Drive: It is also known as a USB flash drive that includes flash 

memory with an integrated USB interface. We can directly connect these 

devices to our computers and laptops and read/write data into them in a 

much faster and efficient way. These devices are very portable. It ranges 

from 1GB to 256GB generally. 
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 (ii) SSD: It stands for Solid State Drive, a mass storage device like HDDs. 

It is more durable because it does not contain optical disks inside like hard 

disks. It needs less power as compared to hard disks, is lightweight, and 

has 10x faster read and write speed as compared to hard disks. But, these 

are costly as well. While SSDs serve an equivalent function as hard 

drives, their internal components are much different. Unlike hard drives, 

SSDs don’t have any moving parts and thus they’re called solid-state 

drives. Instead of storing data on magnetic platters, SSDs store data using 

non-volatile storage. Since SSDs haven’t any moving parts, they do not 
need to “spin up”. It ranges from 150GB to a few and more TB. 

(iii) SD Card: It is known as a Secure Digital Card. It is generally used with 

electronic devices like phones, digital cameras, etc. to store larger data. 

It is portable and the size of the SD card is also small so that it can easily 

fit into electronic devices. It is available in different sizes like 2GB, 4GB, 

8GB, etc. 

 

(iv) Memory Card: It is generally used in digital cameras. printers, game 

consoles, etc. It is also used to store large amounts of data and is 

available in different sizes. To run a memory card on a computer you 

require a separate memory card reader.   

 

(v) Multimedia Card: It is also known as MMC. It is an integrated circuit 

that is generally used in-car radios, digital cameras, etc. It is an external 

device to store data/information. 
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4. Optical Storage Devices 

Optical Storage Devices is also a secondary storage device. It is a 

removable storage device. Following are some optical storage devices: 

(i) CD: It is known as Compact Disc. It contains tracks and sectors on its 

surface to store data. It is made up of polycarbonate plastic and is circular 

in shape. CD can store data up to 700MB. It is of two types: 

 CD-R: It stands for Compact Disc read-only. In this type of CD, 

once the data is written can not be erased. It is read-only. 

 CD-RW: It stands for Compact Disc read Write. In this type of CD, 

you can easily write or erase data multiple times. 

 

(ii) DVD: It is known as Digital Versatile Disc. DVDs are circular flat optical 

discs used to store data. It comes in two different sizes one is 4.7GB 

single-layer discs and another one is 8.5GB double-layer discs. DVDs 

look like CDs but the storage capacity of DVDs is more than as compared 

to CDs. It is of two types: 

 DVD-R: It stands for Digital Versatile Disc read-only. In this type 

of DVD, once the data is written can not be erased. It is read-only. 

It is generally used to write movies, etc. 

 DVD-RW: It stands for Digital Versatile Disc read Write. In this type 

of DVD, you can easily write or erase data multiple times. 

6.3. Internal & External parts of Hardware and software 

Internal computer hardware components 

 Motherboard. ... 

 CPU. ... 

 RAM. ... 

 Hard drive. ... 

 Solid-state drive (SSD). ... 

 Optical drive. ... 
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 Heat sink. ... 

 Graphics processing unit. 

Internal computer software components 

 System software and application software. 

6.4 Summary 

A storage unit is a part of the computer system which is employed to store 

the information and instructions to be processed.  

A storage device is an integral part of the computer hardware which stores 

information/data to process the result of any computational work. 

6.5. Keywords 

Internal, External, CD, DVD, SD card and Memory 

6.6. Terminal Questions 

1. Write about storage device. 

2. What is the use storage device? 

3. Write any two hardware. 

4. What is the use of hardware? 

5. Write any two storage media. 

Let us Sum Up 

In this unit you have learned the followings: 

 To know the use of memory system  

 Types of memory and uses. 

 Input and output are insert data and display a result. 

Check your Progress 

1.  Memory is used to    ___________ 

2.  Memory types are  ____________ 

3.  Primary memory are   ________ 

4.  ____________ is secondary memory. 
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Glossary 

Memory :  Used to store program . 

Floppy :  is secondary memory 

Hard disk :  is a secondary memory 

RAM, ROM : is a Primary memory 

Answer to Check your Progress 

1. Store the program 

2. Two 

3. RAM and ROM 

4. Hard disk 
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1. H N Tiwari and Hem Chand Jain (2020), Computer Applications in 

Business CBCS (Choice Based Credit System), 6th Edition, Taxmann 

Publications. 

2. Dr. Sandeep Srivastava, Dr. Mirza Shab Shah, Er. Meera Goyal (2021), 

Computer Applications in Business (Latest Edition), 1st Edition, SBPD 

Publications. 

3. Er. Meera Goyal, Dr. Sandeep Srivastava(2022), Computer 

Applications in Business, 1st  Edition , SBPD Publications. 

  

https://www.flipkart.com/books/er-meera-goyal~contributor/pr?sid=bks
https://www.flipkart.com/books/dr-sandeep-srivastava~contributor/pr?sid=bks
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Unit-7 
System Software: Operating System  

STURCTURE 

Overview 

Objectives 

7.1. System software 

7.2. Introduction to Operating systems  

7.3. Types of operating systems 

7.4. Summary 

7.5. Keywords 

7. 6.Terminal Questions 

Let us Sum up 

Check your progress 

Glossary 

Answer to check your progress 

Suggested Reading 

Overview  

In this unit the learners will learn and study about the System software, 

Introduction to Operating systems and Types of operating systems. 

Objectives  

After completion of this unit, you will be able to: 

 To understand the system software and application software 

 To learn about operating systems  

 Identify the roles, skills and functions of computer functionality  

 To clear idea of computer utilizations. 

7.1. System software 

System software is a type of computer program that is designed to run a 

computer's hardware and application programs. If we think of the 

computer system as a layered model, the system software is the interface 

between the hardware and user applications. The operating system is the 

best-known example of system software. 

System software is used to manage the computer itself. It runs in the 

background, maintaining the computer's basic functions so users can run 
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higher-level application software to perform certain tasks. Essentially, 

system software provides a platform for application software to be run on 

top of. 

Important features of system software 

Computer manufacturers usually develop the system software as an 

integral part of the computer. The primary responsibility of this software is 

to create an interface between the computer hardware they manufacture 

and the end user. 

System software generally includes the following features: 

1. High speed. System software must be as efficient as possible to 

provide an effective platform for higher-level software in the 

computer system. 

2. Hard to manipulate. It often requires the use of a programming 

language, which is more difficult to use than a more intuitive user 

interface (UI). 

3. Written in a low-level computer language. System software must 

be written in a computer language the central processing unit 

(CPU) and other computer hardware can read. 

4. Close to the system. It connects directly to the hardware that 

enables the computer to run. 

5. Versatile. System software must communicate with both the 

specialized hardware it runs on and the higher-level application 

software that is usually hardware-agnostic and often has no direct 

connection to the hardware it runs on. System software also must 

support other programs that depend on it as they evolve and 

change. 

7.2. Introduction to Operating System 

An Operating System (OS) is system software that manages computer 

hardware, software resources, and provides common services for 

computer programs. 

Time-sharing operating systems schedule tasks for efficient use of the 

system and may also include accounting software for cost allocation 

of processor time, mass storage, printing, and other resources. 

For hardware functions such as input and output and memory allocation, 

the operating system acts as an intermediary between programs and the 

computer hardware, although the application code is usually executed 

directly by the hardware and frequently makes system calls to an OS 

https://www.techtarget.com/searchapparchitecture/tip/10-of-the-best-programming-languages-to-learn-in-2020
https://www.techtarget.com/searchapparchitecture/tip/10-of-the-best-programming-languages-to-learn-in-2020
https://en.wikipedia.org/wiki/System_software
https://en.wikipedia.org/wiki/Computer_hardware
https://en.wikipedia.org/wiki/Computer_hardware
https://en.wikipedia.org/wiki/Computer_software
https://en.wikipedia.org/wiki/Daemon_(computing)
https://en.wikipedia.org/wiki/Computer_program
https://en.wikipedia.org/wiki/Time-sharing
https://en.wikipedia.org/wiki/Scheduler_(computing)
https://en.wikipedia.org/wiki/Scheduling_(computing)
https://en.wikipedia.org/wiki/Mass_storage
https://en.wikipedia.org/wiki/Input_and_output
https://en.wikipedia.org/wiki/Memory_allocation
https://en.wikipedia.org/wiki/System_call
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function or is interrupted by it. Operating systems are found on many 

devices that contain a computer – from cellular phones and video game 

consoles to web servers and supercomputers. 

7.3. Types of operating systems 

 Batch operating systems. The batch operating system does not 

have a direct link with the computer. ... 

 Time-sharing or multitasking operating systems. ... 

 Distributed operating systems. ... 

 Network operating systems. ... 

 Real-time operating systems. ... 

 Mobile operating systems. ... 

 Microsoft Windows. ... 

 Apple iOS 

7.4. Summary 

An operating system (OS) is system software that manages computer 

hardware,  software  resources  and provides common services for 

computer programs. 

Time-sharing operating systems schedule tasks for efficient use of the 

system and may also include accounting software for cost allocation 

of processor time, mass storage, printing, and other resources. 

7.5. Keywords 

System software, Speed, Time sharing and distributed 

7.6. Terminal Questions 

1. What is operating system? 

2. Write the use of operating system. 

3. Write any operating system in briefly. 

4. What is meant by system software? 

5. Write any two system software. 

  

https://en.wikipedia.org/wiki/Interrupt
https://en.wikipedia.org/wiki/Web_server
https://en.wikipedia.org/wiki/Supercomputer
https://en.wikipedia.org/wiki/System_software
https://en.wikipedia.org/wiki/Computer_hardware
https://en.wikipedia.org/wiki/Computer_hardware
https://en.wikipedia.org/wiki/Computer_software
https://en.wikipedia.org/wiki/Daemon_(computing)
https://en.wikipedia.org/wiki/Computer_program
https://en.wikipedia.org/wiki/Time-sharing
https://en.wikipedia.org/wiki/Scheduler_(computing)
https://en.wikipedia.org/wiki/Scheduling_(computing)
https://en.wikipedia.org/wiki/Mass_storage
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Let us Sum Up 

In this unit you have learned the followings: 

 Creating documents are business system  

 Program is set of coding or source code that will fulfil the user need 

or user expectation. 

 Input and output are insert data and display a result. 

Check your Progress 

1.  System software is used to manage    ___________ 

2.  Operating system is  ____________ in process 

3.  Computers are two parts  ________ and ______ 

4.  ____________ is used to store large types of program . 

Glossary 

Program :  The set of instruction is called program. 

Data :  used to construct program  

Input :  used to raw material 

Output :  To display the result or value 
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Answer to check your progress 

1. Computer itself 

2. Kernal 

3. Hardware and Software 

4. Hard disk 

Suggested Reading 

1. H N Tiwari and Hem Chand Jain (2020), Computer Applications in 

Business CBCS (Choice Based Credit System), 6th Edition, Taxmann 

Publications. 

2. Dr. Sandeep Srivastava, Dr. Mirza Shab Shah, Er. Meera Goyal (2021), 

Computer Applications in Business (Latest Edition), 1st Edition, SBPD 

Publications. 

3. Er. Meera Goyal, Dr. Sandeep Srivastava (2022), Computer 

Applications in Business, 1st  Edition , SBPD Publications. 

https://www.flipkart.com/books/er-meera-goyal~contributor/pr?sid=bks
https://www.flipkart.com/books/dr-sandeep-srivastava~contributor/pr?sid=bks
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Unit-8 
Application Software - Internet 

STURCTURE 

Overview 

Objectives 

8.1.Introduction to software 

8.2.Application software 

8.3.Definition of Internet 

8.4.Summary 

8.5. Keywords 

8.6.Terminal Questions 

Let us Sum up 

Check your progress 

Glossary 

Answer to check your progress 

Suggested Reading 

Overview  

In this unit the learners will learn and study about the Introduction to 

software,  Application software  and Definition of Internet. 

Objectives  

After completion of this unit, you will be able to: 

 To understand the concepts of software. 

 To learn about types of software 

 To understand the concepts of Internet. 

8.1. Introduction to software 

Software: 

Software is known as programs or apps, comprising of all the instructions 

that direct the hardware in performing tasks. These instructions come from 

a software developer in the form and are accepted by the platform 

(Operating System + CPU) that they are based on. Software is capable 

enough to perform numerous tasks, compared to hardware that can only 

perform mechanical tasks they are designed for. Software provides the 

means for accomplishing many different tasks with the same basic 
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hardware. Practical computer systems divide software systems into two 

parts:  

System Software:  

System software is designed for controlling and working with computer 

hardware. It allow users to interact directly with hardware functionality, like 

the device manager and many of the utilities found in the control panel. It 

consists of operating systems, device drivers, diagnostic tools, etc. and is 

almost always pre-installed in computers and smart phones, examples 

are Windows 10, Linux, Macintosh, Android. 

 8.2. Application Software: 

 Application software is capable of dealing with user inputs and helping 

them to complete tasks. It resides above the system software and allows 

users to accomplish one or more tasks. It is programmed for simple as 

well as complex tasks. It can either be a single program or a group of 

programs that are referred to as an application suite. Some examples of 

application software are Word Processing Software, Web Browsing, 

Spreadsheet Software, Presentation, Graphics, Multimedia YouTube, 

Computer Aided Design (CAD)/Computer Aided Manufacturing (CAM), 

sending email, accounting software, customised shopping apps and cloud 

based applications such as Google docs.  

8.3. Definition of Internet 

The Internet (or internet) is the global system of interconnected computer 

networks that uses the Internet protocol suite (TCP/IP) to communicate 

between networks and devices. It is a network of networks that consists 

of private, public, academic, business, and government networks of local 

to global scope, linked by a broad array of electronic, wireless, and optical 

networking technologies. The Internet carries a vast range of information 

resources and services, such as the inter-linked hypertext documents 

and applications of the World Wide Web (WWW) ,  electronic 

mail,  telephony, and file sharing. 

The origins of the Internet date back to the development of packet 

switching and research commissioned by the United States Department 

of Defense in the 1960s to enable time-sharing of computers. The primary 

precursor network, the ARPANET, initially served as a backbone for 

interconnection of regional academic and military networks in the 1970s. 

The funding of the National Science Foundation Network as a new 

backbone in the 1980s, as well as private funding for other commercial 

extensions, led to worldwide participation in the development of new 

https://en.wikipedia.org/wiki/Computer_network
https://en.wikipedia.org/wiki/Computer_network
https://en.wikipedia.org/wiki/Internet_protocol_suite
https://en.wikipedia.org/wiki/Internetworking
https://en.wikipedia.org/wiki/Optical_networking
https://en.wikipedia.org/wiki/Optical_networking
https://en.wikipedia.org/wiki/Hypertext
https://en.wikipedia.org/wiki/Web_application
https://en.wikipedia.org/wiki/Email
https://en.wikipedia.org/wiki/Email
https://en.wikipedia.org/wiki/Internet_telephony
https://en.wikipedia.org/wiki/File_sharing
https://en.wikipedia.org/wiki/Packet_switching
https://en.wikipedia.org/wiki/Packet_switching
https://en.wikipedia.org/wiki/United_States_Department_of_Defense
https://en.wikipedia.org/wiki/United_States_Department_of_Defense
https://en.wikipedia.org/wiki/Time-sharing
https://en.wikipedia.org/wiki/ARPANET
https://en.wikipedia.org/wiki/National_Science_Foundation_Network
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networking technologies, and the merger of many networks. The linking 

of commercial networks and enterprises by the early 1990s marked the 

beginning of the transition to the modern Internet, and generated a 

sustained exponential growth as generations of institutional, personal, 

and mobile computers were connected to the network.  

Although the Internet was widely used by academia in the 

1980s,  commercialization  incorporated  its services and technologies 

into virtually every aspect of modern life. 

8.4. Summary 

The Internet is the global system of interconnected computer 

networks that uses the Internet Protocol suite (TCP/IP) to communicate 

between networks and devices.  

It is a network of networks that consists of private, public, academic, 

business, and government networks of local to global scope, linked by a 

broad array of electronic, wireless, and optical networking technologies. 

8.5. Keywords 

Internet, TCP/IP, WWW and Application software 

8.6. Terminal Questions 

1. What is the use of Internet? 

2. What is mean by WWW?  

3. Write notes on software  

4. Write about the types of software? 

5. Write the use of application software. 

Let us Sum Up 

In this unit you have learned the followings: 

 Creating documents are business system  

 Program is set of coding or source code that will fulfil the user need 

or user expectation. 

 Input and output are insert data and display a result. 

Check your Progress 

1.  There are two types software are    ___________ , _____ 

2.  Internet is  ____________ connected systems 

3.  WWW means  ________ 

https://en.wikipedia.org/wiki/Personal_computer
https://en.wikipedia.org/wiki/Mobile_device
https://en.wikipedia.org/wiki/Computer
https://en.wikipedia.org/wiki/Academia
https://en.wikipedia.org/wiki/Commercialization_of_the_Internet
https://en.wikipedia.org/wiki/Computer_network
https://en.wikipedia.org/wiki/Computer_network
https://en.wikipedia.org/wiki/Internet_protocol_suite
https://en.wikipedia.org/wiki/Internetworking
https://en.wikipedia.org/wiki/Optical_networking
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4.  Web browsing is  a ________. 

Glossary 

Program :  The set of instruction is called program. 

Data :  used to construct program  

Input :  used to raw material 

Output :  To display the result or value 

Answer to Check your Progress 

1. System software and application software 

2. Global  

3. World Wide Web 

4. Application software 

Suggested Reading 

1. H N Tiwari and Hem Chand Jain (2020), Computer Applications in 

Business CBCS (Choice Based Credit System), 6th Edition, Taxmann 

Publications. 

2. Dr. Sandeep Srivastava, Dr. Mirza Shab Shah, Er. Meera Goyal (2021), 

Computer Applications in Business (Latest Edition), 1st Edition, SBPD 

Publications. 

3. Er. Meera Goyal, Dr. Sandeep Srivastava(2022), Computer 

Applications in Business 1st  Edition , SBPD Publications. 

  

https://www.flipkart.com/books/er-meera-goyal~contributor/pr?sid=bks
https://www.flipkart.com/books/dr-sandeep-srivastava~contributor/pr?sid=bks
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Block-3:  Introduction  

The Block-3: File Operations has been divided into four Units (Unit-9 to 

Unit-12). 

Unit-9: Microsoft Word deals with Definition of MS word, MS word 

History, Version of Word and Features of word such as file creation. 

Unit-10: Formatting and Editing of paragraph explains about 

Formatting, Editing of Paragraph, Formatting of Paragraph 

Unit-11: Inserting header and footer and page number describes 

about Notes on Header and footer, Inserting Header and footer and 

Inserting Page Number 

Unit-12: Inserting tables, print review and printing presents about 

Inserting Tables, Inserting Symbols and Print command and review. 

In all the units of Block -3: File Operations, the Check your progress, 

Glossary, Answers to Check your progress and Suggested Reading has 

been provided and the Learners are expected to attempt all the Check 

your progress as part of study.  
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Unit-9 
MS-Word 

STURCTURE 

Overview 

Objectives 

9.1. Definition of MS word 

9.2. MS word History 

9.3. Version of Word 

9.4. Features of word such as file creation 

9.5.Summary 

9.6.Keywords 

9.7.Terminal Questions 

Let Us Sum Up 

Check Your Progress 

Answer to Check Your Progress 

Overview  

In this unit the learners will learn and study about the basic functionality 

of Definition of MS word, MS word History, Version of Word and Features 

of word such as file creation. 

Objectives  

After completion of this unit, you will be able to: 

 Describe the purpose computer devices 

 Identify the roles, skills and functions of computer functionality  

 To clear idea of computer utilizations. 

 To learn about MS word and how to create a new document 

 To understand of word application usages. 

9.1. Definition of Ms Word 

Microsoft Word is a widely used commercial word processor designed by 

Microsoft. Microsoft Word is a component of the Microsoft Office suite of 

productivity software, but can also be purchased as a stand-alone 

product. 

Microsoft Word was initially launched in 1983, and has since been revised 

numerous times. It is available for both Windows and Apple operating 

systems. Microsoft Word is often called simply Word or MS Word. 
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9.2. MS Word history 

In 1981, Microsoft hired Charles Simonyi to develop a word-processing 

application. The first version was released in 1983. 

Initially, MS Word was not very popular, owing to its radically different look 

compared to WordPerfect, the leading word processor at that time. 

However, Microsoft improved Word continually over the years, including 

a 1985 version that could run on a Mac.  

The second major release of Word, in 1987, included an upgrade of major 

features, in addition to new functionalities such as support for Rich Text 

Format (RTF). 

In 1995, Microsoft increased its market share in the word processor 

business with the release of Windows 95 and Office 95, which offered a 

bundled set of office productivity software. 

Some features that have made MS Word useful include a WYSIWYG 

(what-you-see-is-what-you-get) display: this design ensures that 

everything displayed on screen appears the same way when printed or 

moved to another format or program.  

The ability of users to copy and paste MS Word content into many other 

platforms without significant formatting loss is one reason the software 

has stayed so popular in the last two decades. 

In addition, MS Word has a built-in dictionary for spell checking; 

misspelled words are marked with a red squiggly underline. MS Word 

offers text-level features such as bold, underline, italic and strike-through, 

and page-level features such as indentation, paragraphing and 

justification.  

Word is compatible with many other programs, the most common being 

the other members of the Office suite. 

In 2007, .docx became the default file format, replacing the “.doc” 
extension. 

As Microsoft Word modernized over time, so did Microsoft operating 

systems. Since the Microsoft Office suite is inherently tied to the Microsoft 

operating system, its use featured in user frustrations around end-of-life 

for Microsoft XP and the successive Vista and Windows 7, 8 and 10 

additions. 
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9.3. Version of word 

Year released Name Version 

2010 Word 2010 14.0 

2013 Word 2013 15.0 

2016 Word 2016 16.0 

2019 Word 2019 16.0 

 

9.4. Features of word such as file creation 

Home 

This has options like font colour, font size, font style, alignment, bullets, 

line spacing, etc. All the basic elements which one may need to edit their 

document is available under the Home option. 

Insert 

Tables, shapes, images, charts, graphs, header, footer, page number, 

etc. can all be entered in the document. They are included in the “Insert” 
category. 

Design 

The template or the design in which you want your document to be created 

can be selected under the Design tab. Choosing an appropriate tab will 

enhance the appearance of your document. 
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Page Layout 

Under the Page Layout tab comes options like margins, orientation, 

columns, lines, indentation, spacing, etc.  

References 

This tab is the most useful for those who are creating a thesis or writing 

books or lengthy documents. Options like citation, footnote, table of 

contents, caption, bibliography, etc. can be found under this tab. 

Review 

Spell check, grammar, Thesaurus, word count, language, translation, 

comments, etc. can all be tracked under the review tab. This acts as an 

advantage for those who get their documents reviewed on MS Word. 

Apart from all the above-mentioned features, the page can be set in 

different views and layouts, which can be added and optimised using the 

View tab on the Word document. Margins and scales are also available 

for the benefit of the users. When compared with MS PowerPoint, MS 

Word is more of reading while PPT is more of visual and graphical 

representation of data.  

9.5.Summary 

Microsoft Word is a widely used commercial word processor designed by 

Microsoft. Microsoft Word is a component of the Microsoft Office suite of 

productivity software, but can also be purchased as a stand-alone 

product. 

9.6.Keywords 

MS Word, Page, Insert, Home and Features 

9.7.Terminal Questions 

1. What is the use of word? 

2. Write about the functions of word. 

3. Write the difference properties or word. 

4. Write advantage of word. 

5. Write any four menus using Ms word. 

Check your Progress 

1.  Ms-word used to create   ___________ 

2.  Ms-word is easy to __________ user 

3.  There are _____ types of alignments 

4.  Document _____ is possible in MS-word. 

https://byjus.com/govt-exams/microsoft-powerpoint/
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Let Us Sum Up 

In this unit you have learned the followings: 

 Creating documents are business system  

 Program is set of coding or source code that will fulfil the user need 

or user expectation. 

 Input and output are insert data and display a result. 

Glossary 

Program :  The set of instruction is called program. 

Data :  used to construct program  

Input :  used to raw material 

Output :  To display the result or value 

Answer to Check your Progress 

1. Documents 

2. Handle 

3. Four  

4. Edit 

Suggested Reading 

1. H N Tiwari and Hem Chand Jain (2020), Computer Applications in 

Business CBCS (Choice Based Credit System), 6th Edition, Taxmann 

Publications. 

2. Dr. Sandeep Srivastava, Dr. Mirza Shab Shah, Er. Meera Goyal (2021), 

Computer Applications in Business (Latest Edition), 1st Edition, SBPD 

Publications. 

3. Er. Meera Goyal, Dr. Sandeep Srivastava(2022), Computer 

Applications in Business, 1st  Edition , SBPD Publications. 

  

https://www.flipkart.com/books/er-meera-goyal~contributor/pr?sid=bks
https://www.flipkart.com/books/dr-sandeep-srivastava~contributor/pr?sid=bks
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Unit-10 
Formatting and Editing of Paragraph  

STURCTURE 

Overview 

Objectives 

10.1.Formatting 

10.2.Editing of Paragraph  

10.3.Formatting of Paragraph 

10.4.Summary 

10.5.Keywords 

10.6.Terminal Questions 

Let us Sum up 

Check your progress 

Glossary 

Answer to check your progress 

Suggested Reading 

Overview  

In this unit the learners will learn and study about the basic functionality 

of Formatting,  Editing of Paragraph and Formatting of Paragraph. 

Objectives  

After completion of this unit, you will be able to: 

 Describe the purpose computer devices 

 Identify the roles, skills and functions of computer functionality  

 To clear idea of computer utilizations. 

 To learn about text formation and editing. 

 To align and summary of paragraph. 

10.1. Formatting 

Format text 

1. Select the text you want to format. To select a single word, double-

click it. To select a line of text, click to the left of it. 

2. Select an option to change the font, font size, font color, or make 

the text bold, italic, or underline. 
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Formatted text can draw the reader's attention to specific parts of a 

document and emphasize important information. In Word, you have 

several options for adjusting text, including font, size, and color. You can 

also adjust the alignment of the text to change how it is displayed on the 

page. 

10.2. Editing of Paragraph 

While editing your paragraph, make sure that it follows correct paragraph 

structure. It should have a topic sentence with a clear focus, and include 

details that support the topic sentence. Your paragraph should also be 

free of spelling, punctuation and grammar errors. 

While editing your paragraph, make sure that it follows correct paragraph 

structure. It should have a topic sentence with a clear focus, and include 

details that support the topic sentence. Your paragraph should also be 

free of spelling, punctuation and grammar errors. You should always 

spell- and grammar-check your writing. Remember that the spell-check 

feature on your computer will not help if you spell the word correctly, but 

use it incorrectly. Use a dictionary or a thesaurus if you are unsure how a 

word is used. To edit your paragraph, read it carefully. Reading it out loud 

can be more effective than reading it silently. You can also ask someone 

else to proofread it for errors. 

10.3. Formatting of Paragraph 

Paragraph formatting is a change in the format of text that affects an entire 

paragraph or is different from other paragraphs in a document. 

Paragraphs in a word processing document or on a web page can have 

paragraph formatting applied to them, including alignment, font type, font 

size, highlighting, and indentation. 

Change font size 

Change font type 

Change font color 

Change bold and italics formatting 

Change color highlighting 

Change paragraph indentation 
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10.4. Summary 

Paragraph formatting is a change in the format of text that affects an 

entire paragraph or is different from other paragraphs in a document. 

10.5 Keywords 

Text, Paragraph, Format, Edit and colours. 

10.6 Terminal Questions 

1. What is paragraph format? 

2. Write the classification of formatting? 

3. Write the use editing. 

Let us Sum Up 

In this unit you have learned the followings: 

 Creating documents are business system  

 Program is set of coding or source code that will fulfil the user need 

or user expectation. 

 Input and output are insert data and display a result. 

Check your Progress 

1.  Paragraph alignment is called    ___________ 

2.  Formation of Paragraph is to align _____ 

3.  The font colour change is _______ in MS-Word 

4.  Alignments are Left, right and ______, ______. 

Glossary 

Program :  The set of instruction is called program. 

Data :  used to construct program  

Input :  used to raw material 

Output :  To display the result or value 
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Answer to Check your Progress 

1. Editing 

2. Text 

3. Possible 

4. Centre and Justificateion 

Suggested Reading 

1. H N Tiwari and Hem Chand Jain (2020), Computer Applications in 

Business CBCS (Choice Based Credit System), 6th Edition, Taxmann 

Publications. 

2. Dr. Sandeep Srivastava, Dr. Mirza Shab Shah, Er. Meera Goyal (2021), 

Computer Applications in Business (Latest Edition), 1st Edition, SBPD 

Publications. 

3. Er. Meera Goyal, Dr. Sandeep Srivastava(2022), Computer 

Applications in Business ,1st  Edition , SBPD Publications. 

  

https://www.flipkart.com/books/er-meera-goyal~contributor/pr?sid=bks
https://www.flipkart.com/books/dr-sandeep-srivastava~contributor/pr?sid=bks
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Unit-11 
Inserting Header , Footer and Page Number 

STURCTURE 

Overview 

Objectives 

11.1. Notes on Header and footer 

11.2. Inserting Header and footer 

11.3. Inserting Page Number 

11.4. Summary 

11.5. Keywords 

11.6. Terminal Questions 

Let us Sum up 

Check your progress 

Glossary 

Answer to check your progress 

Suggested Reading 

Overview  

In this unit the learners will learn and study about the basic functionality 

of Notes on Header and footer,  Inserting Header and footer  and Inserting 

Page Number. 

Objectives  

After completion of this unit, you will be able to: 

 Describe the purpose computer devices 

 Identify the roles, skills and functions of computer functionality  

 To clear idea of computer utilizations. 

 To learn about put the page number in automatically. 

 To write any notes or hint or foot mark using header and footer. 

11.1. Notes on Header and footer 

Headers and footers are the top and bottom sections of the document 

respectively. They are separate sections from the main document, and 

are often used to hold footnotes, page numbers, titles, and other 

information. The Header and Footer options each contain a dropdown 

menu. 
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A header is text that is placed at the top of a page, while a footer is placed 

at the bottom, or foot, of a page. Typically these areas are used for 

inserting document information, such as the name of the document, the 

chapter heading, page numbers, creation date and the like. 

11.2. Inserting Header and footer 

1. Go to Insert > Header or Footer. 

2. Choose the header style you want to use. ... 

3. Add or change text for the header or footer. For more info on 

things you can do with headers, see Edit your existing headers 

and footers. To edit a header or footer that's been already 

created, double-click on it. 

4. To eliminate a header--like deleting it on the title page--select it 

and then check the Different First Page box. 

5. Select Close Header and Footer or press Esc to exit. 

11.3. Inserting Page number 

1. Select Insert > Page Number, and then choose the location and 

style you want. 

2. If you don't want a page number to appear on the first page, 

select Different First Page. 

3. If you want numbering to start with 1 on the second page, go 

to Page Number > Format Page Numbers, and set Start at to 0. 

4. When you're done, select Close Header and Footer or press Esc. 

A header or footer can contain text, information about the document, or 

even images. However, the most common elements in a header or footer 

are page numbers. Page numbers can be continuous though a document, 

all but the first page, or start over in each section. 

11.4. Summary 

Headers and footers are the top and bottom sections of the document 

respectively. They are separate sections from the main document, and 

are often used to hold footnotes, page numbers, titles, and other 

information. 

  

https://support.microsoft.com/en-us/office/edit-your-existing-headers-and-footers-490423a3-3e5b-4080-aff0-c429ab5d6708
https://support.microsoft.com/en-us/office/edit-your-existing-headers-and-footers-490423a3-3e5b-4080-aff0-c429ab5d6708
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11.5. Keywords 

Notes, Header, Footer and Insert 

11.6. Terminal Questions 

1. Write about page number. 

2.  How to insert page number in automatically. 

3. What is the use of header and footer? 

Let us Sum Up 

In this unit you have learned the followings: 

 Creating documents are business system  

 Program is set of coding or source code that will fulfil the user need 

or user expectation. 

 Input and output are insert data and display a result. 

Check your Progress 

1.  The page number is used to the location of    ___________ 

2.  Header is used to __________ 

3,  Footer is used to _____ 

4. Ins button is used to _____ 

Glossary 

Program :  The set of instruction is called program. 

Data :  used to construct program  

Input :  used to raw material 

Output :  To display the result or value 
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Answer to Check your Progress 

1. Header or Footer 

2. Insert command in all pages 

3. Insert page number  

4. Insert data 

Suggested Reading 

1. H N Tiwari and Hem Chand Jain (2020), Computer Applications in 

Business CBCS (Choice Based Credit System), 6th Edition, Taxmann 

Publications. 

2. Dr. Sandeep Srivastava, Dr. Mirza Shab Shah, Er. Meera Goyal (2021), 

Computer Applications in Business (Latest Edition), 1st Edition, SBPD 

Publications. 

3. Er. Meera Goyal, Dr. Sandeep Srivastava(2022), Computer 

Applications in Business, 1st  Edition , SBPD Publications. 

  

https://www.flipkart.com/books/er-meera-goyal~contributor/pr?sid=bks
https://www.flipkart.com/books/dr-sandeep-srivastava~contributor/pr?sid=bks
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Unit-12 

Inserting Tables, Print Review and Printing  

STURCTURE 

Overview 

Objectives 

12.1. Inserting Tables 

12.2. Inserting Symbols 

12.3. Print command and review 

12.4. Summary 

12.5. Keywords 

12.6. Terminal Questions 

Let us Sum up 

Glossary 

Suggested Reading 

Overview  

In this unit the learners will learn and study about the basic functionality 

of Inserting Tables, Inserting Symbols and Print command and review. 

Objectives  

After completion of this unit, you will be able to: 

 Describe the purpose computer devices 

 Identify the roles, skills and functions of computer functionality  

 To clear idea of computer utilizations. 

 To study and learn the concepts of insert a table in word. 

 To study about insert symbol and print command. 

12.1. Inserting table 

1. Put your cursor where you want to add the table of contents. 

2. Go to References > Table of Contents and choose an automatic 

style. 
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3. If you make changes to your document that affect the table of 

contents, update the table of contents by right-clicking the table 

of contents and choosing Update Field. 

12.2. Inserting symbols 

Go to Insert > Symbol > More Symbols. Go to Special 

Characters. Double-click the character that you want to insert. Select 

Close. 

1. Place your cursor in the file at the spot where you want to insert 

the symbol. 

2. Go to Insert > Symbol. 

3. Pick a symbol, or choose More Symbols. 

4. Scroll up or down to find the symbol you want to insert. 

Different font sets often have different symbols in them and the most 

commonly used symbols are in the Segoe UI Symbol font set. Use 

the Font selector above the symbol list to pick the font you want to browse 

through. 

5. When you find the symbol you want, double-click it. The symbol 

will be inserted in your file. 

6. Select Close. 

12.3. Print command and review 

Print a document in Word 

1. Select File > Print. 
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2. To preview each page, select the forward and backward arrows 

at the bottom of the page. If the text is too small to read, use the 

zoom slider at the bottom of the page to enlarge it. 

3. Choose the number of copies, and any other options you want, 

and select the Print button. 

4. Print preview is a feature that displays on the screen what a hard 

copy would look like when printed. Using print preview, you can 

find any errors that may exist or fix the layout before printing, which 

can save ink or toner and paper by not having to print more than 

once. 

5. To open the print preview feature, click the print preview icon on 

the toolbar, like that shown in the picture, or click File and choose 

the Print Preview option. 

12.4. Summary 

Print preview is a feature that displays on the screen what a hard 

copy would look like when printed.  

Using print preview, you can find any errors that may exist or fix the layout 

before printing, which can save ink or toner and paper by not having to 

print more than once. 

12.5. Keywords 

Table, Insert, Delete, Print and Print preview 

12.5. Terminal Questions 

1. How to insert a table? 

2. How to insert a symbol? 

3. What is the use of print preview? 

4. How to print documents? 

Let us Sum Up 

In this unit you have learned the followings: 

 Creating documents are business system  

 Program is set of coding or source code that will fulfil the user need 

or user expectation. 

 Input and output are insert data and display a result. 

  

https://www.computerhope.com/jargon/h/hardcopy.htm
https://www.computerhope.com/jargon/h/hardcopy.htm
https://www.computerhope.com/jargon/i/ink.htm
https://www.computerhope.com/jargon/t/toner.htm
https://www.computerhope.com/jargon/t/toolbar.htm
https://www.computerhope.com/jargon/h/hardcopy.htm
https://www.computerhope.com/jargon/h/hardcopy.htm
https://www.computerhope.com/jargon/i/ink.htm
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Check your Progress 

1.  Table insert in particular location in Document is  ___________ 

2. Insert symbol is used the key _____ 

3.  Ctrl +  C Key is _______ 

4.Paste command key is ____ 

Glossary 

Program :  The set of instruction is called program. 

Data :  used to construct program  

Input :  used to raw material 

Output :  To display the result or value 

Answer to your Progress 

1.  Insert Table  

2. Insert  

3, Copy command 

4. Ctrl + V 

Suggested Reading 

1. H N Tiwari and Hem Chand Jain (2020), Computer Applications in 

Business CBCS (Choice Based Credit System), 6th Edition, Taxmann 

Publications. 

2. Dr. Sandeep Srivastava, Dr. Mirza Shab Shah, Er. Meera Goyal (2021), 

Computer Applications in Business (Latest Edition), 1st Edition, SBPD 

Publications. 

3. Er. Meera Goyal, Dr. Sandeep Srivastava(2022), Computer 

Applications in Business, 1st  Edition , SBPD Publications. 

  

https://www.flipkart.com/books/er-meera-goyal~contributor/pr?sid=bks
https://www.flipkart.com/books/dr-sandeep-srivastava~contributor/pr?sid=bks
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Block-4:  Introduction  

The Block-4: Microsoft Excel has been divided into five Units (Unit-13 

to Unit-16). 

Unit-13: Microsoft Excel Introduction deals with the History of Microsoft 

Excel and Version of Microsoft Excel. 

Unit-14: Features of Excel explains about the Excel Sheet, Features of 

Excel Sheet and Excel sheet creation. 

Unit-15: Formatting the worksheet describes about the Formatting of 

Excel sheet, Editing of Excel Sheet and Organizing the worksheet. 

Unit-16: Formulas and Functions presents about Worksheet using 

formulas and functions and Worksheet data sorting and filtering. 

Unit-17: Creating Charts deals with Creating charts using Excel a Print 

and review command using excel. 

In all the units of Block -4: Microsoft Excel, the Check your progress, 

Glossary, Answers to Check your progress and Suggested Reading has 

been provided and the Learners are expected to attempt all the Check 

your progress as part of study.  
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Unit-13 
Microsoft Excel Introduction 

STURCTURE 

Overview 

Objectives 

13.1. Microsoft Excel 

13.2. History and version of Excel 

13.3. Summary 

13.4. Keywords 

13.5. Terminal Questions 

Let us Sum up 

Check your progress 

Glossary 

Answer to check your progress 

Suggested Reading 

Overview  

In this unit the learners will learn and study about the basic functionality 

of Microsoft Excel and History and version of Excel. 

Objectives  

After completion of this unit, you will be able to: 

 Describe the purpose computer devices 

 Identify the roles, skills and functions of computer functionality  

 To clear idea of computer utilizations. 

 To study about worksheet in excel. 

 To learn how the data insert into excel sheet. 

 To study about Excel version. 

13.1. Microsoft Excel 

Microsoft Excel is an electronic spreadsheet. You can use it to organize 

your data into rows and columns. You can also use it to perform 

mathematical calculations quickly. This course teaches Microsoft Excel 

basics as a prelude to the use of Statistical Analysis System (SAS) 

software in carrying out more complex statistical analysis. Although 
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knowledge of how to navigate in a Windows environment is helpful, this 

manual is created for the computer novice.  

At the end of the course, participants are expected to know how to use 

Microsoft Excel to:  Enter text and numbers in a spreadsheet 

 

  Enter Excel formulas 

  Format data 

  Create Excel functions 

  Fill cells automatically 

  Print results 

  Create Charts, and 

  Enter advanced Excel formulas 

Microsoft Excel has the basic features of all spreadsheets, using a grid 

of cells arranged in numbered rows and letter-named columns to 

organize  data manipulations like arithmetic operations.  

It has a battery of supplied functions to answer statistical, engineering, 

and financial needs. In addition, it can display data as line graphs, 

histograms and charts, and with a very limited three-dimensional 

graphical display. It allows sectioning of data to view its dependencies on 

various factors for different perspectives (using pivot tables and 

the scenario manager).  

A PivotTable is a tool for data analysis. It does this by simplifying large 

data sets via PivotTable fields. It has a programming aspect, Visual Basic 

for Applications, allowing the user to employ a wide variety of numerical 

methods, for example, for solving differential equations of mathematical 

https://en.wikipedia.org/wiki/Pivot_table
https://en.wikipedia.org/wiki/PivotTable
https://en.wikipedia.org/wiki/Data_analysis
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physics, and then reporting the results back to the spreadsheet. It also 

has a variety of interactive features allowing user interfaces that can 

completely hide the spreadsheet from the user, so the spreadsheet 

presents itself as a so-called application, or Decision Support 

System (DSS). 

13.2. History and version of Excel 

From its first version Excel supported end-user programming of macros 

(automation of repetitive tasks) and user-defined functions (extension of 

Excel's built-in function library). In early versions of Excel, these programs 

were written in a macro language whose statements had formula syntax 

and resided in the cells of special-purpose macro sheets (stored with file 

extension .XLM in Windows.) XLM was the default macro language for 

Excel through Excel 4.0. Beginning with version 5.0 Excel recorded 

macros in VBA by default but with version 5.0 XLM recording was still 

allowed as an option. After version 5.0 that option was discontinued. All 

versions of Excel, including Excel 2010 are capable of running an XLM 

macro, though Microsoft discourages their use. 

Charts 

 

Graph made using Microsoft Excel 

Excel supports charts, graphs, or histograms generated from specified 

groups of cells. It also supports Pivot Charts that allow for a chart to be 

linked directly to a Pivot table. This allows the chart to be refreshed with 

the Pivot Table. The generated graphic component can either be 

embedded within the current sheet or added as a separate object. 

These displays are dynamically updated if the content of cells changes. 

For example, suppose that the important design requirements are 

displayed visually; then, in response to a user's change in trial values for 

parameters, the curves describing the design change shape, and their 

points of intersection shift, assisting the selection of the best design. 

https://en.wikipedia.org/wiki/Graph_of_a_function
https://en.wikipedia.org/wiki/Chart
https://en.wikipedia.org/wiki/Graph_of_a_function
https://en.wikipedia.org/wiki/Histogram
https://en.wikipedia.org/wiki/Pivot_table
https://en.wikipedia.org/wiki/File:Excel_chart.PNG
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13.3. Summary 

Excel supports charts, graphs, or histograms generated from specified 

groups of cells. It also supports Pivot Charts that allow for a chart to be 

linked directly to a Pivot table. 

13.4 Keywords 

Worksheet, Formula, functions, Chart and graphs 

13.5. Terminal Questions 

1. What is the use of excel sheet? 

2. How to insert data into excel? 

3. How the data value is sorted? 

4.  How to insert chart, graph into excel? 

Let us Sum Up 

In this unit you have learned the followings: 

 Creating documents are business system  

 Program is set of coding or source code that will fulfil the user need 

or user expectation. 

 Input and output are insert data and display a result. 

Check your Progress 

1.  The excel sheet is insert of    ___________ and ____ 

2.  Excel is used to construct  ____________ 

3.  The auto sum command is used to   ________ 

4.  IF commands are used to ________. 

Glossary 

Program :  The set of instruction is called program. 

Data :  used to construct program  

Input :  used to raw material 

Output :  To display the result or value 

  

https://en.wikipedia.org/wiki/Chart
https://en.wikipedia.org/wiki/Graph_of_a_function
https://en.wikipedia.org/wiki/Histogram
https://en.wikipedia.org/wiki/Pivot_table
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Answer to Check your Progress 

1. Row and Column 

2. Calculation  

3. Calculate Total value 

4. To check Result value 

Suggested Reading 

1. H N Tiwari and Hem Chand Jain (2020), Computer Applications in 

Business CBCS (Choice Based Credit System), 6th Edition, Taxmann 

Publications. 

2. Dr. Sandeep Srivastava, Dr. Mirza Shab Shah, Er. Meera Goyal (2021), 

Computer Applications in Business (Latest Edition), 1st Edition, SBPD 

Publications. 

3. Er. Meera Goyal, Dr. Sandeep Srivastava(2022), Computer 

Applications in Business, 1st  Edition , SBPD Publications. 

  

https://www.flipkart.com/books/er-meera-goyal~contributor/pr?sid=bks
https://www.flipkart.com/books/dr-sandeep-srivastava~contributor/pr?sid=bks
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Unit-14 
Features of Excel  

STURCTURE 

Overview 

Objectives 

14.1. MS Excel 

14.2. Features of Excel Sheet 

14.3. Excel sheet creation 

14.4. Summary 

14.5. Keywords 

14.6. Terminal Questions 

Let us Sum up 

Check your progress 

Glossary 

Answer to check your progress 

Suggested Reading 

Overview  

In this unit the learners will learn and study about the basic functionality 

of Features of Excel Sheet  and Excel sheet creation. 

Objectives  

After completion of this unit, you will be able to: 

 Describe the purpose computer devices 

 Identify the roles, skills and functions of computer functionality  

 To clear idea of computer utilizations. 

 To study about worksheet in excel. 

 To learn Features of excel sheet. 

 To study about Excel sheet creation. 

14.1. MS Excel 

The Microsoft Excel(MS Excel) is a  spreadsheet  developed 

by  Microsoft for  Windows,  mac OS,  Android and iOS.  It features 

calculation or computation capabilities, graphing tools, pivot tables, and 

a macro programming language called Visual Basic for 

https://en.wikipedia.org/wiki/Spreadsheet
https://en.wikipedia.org/wiki/Microsoft
https://en.wikipedia.org/wiki/Microsoft_Windows
https://en.wikipedia.org/wiki/MacOS
https://en.wikipedia.org/wiki/Android_(operating_system)
https://en.wikipedia.org/wiki/IOS
https://en.wikipedia.org/wiki/Calculation
https://en.wikipedia.org/wiki/Computation
https://en.wikipedia.org/wiki/Pivot_table
https://en.wikipedia.org/wiki/Macro_(computer_science)
https://en.wikipedia.org/wiki/Visual_Basic_for_Applications
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Applications (VBA). Excel forms part of the Microsoft Office suite of 

software. 

Microsoft Excel has the basic features of all spreadsheets, using a grid 

of cells arranged in numbered rows and letter-named columns to 

organize data manipulations like arithmetic operations. It has a battery of 

supplied functions to answer statistical, engineering, and financial needs.  

In addition, it can display data as line graphs, histograms and charts, and 

with a very limited three-dimensional graphical display. It allows 

sectioning of data to view its dependencies on various factors for different 

perspectives (using pivot tables and the scenario manager).  

A PivotTable is a tool for data analysis. It does this by simplifying large 

data sets via PivotTable fields. It has a programming aspect, Visual Basic 

for Applications, allowing the user to employ a wide variety of numerical 

methods, for example, for solving differential equations of mathematical 

physics, and then reporting the results back to the spreadsheet. It also 

has a variety of interactive features allowing user interfaces that can 

completely hide the spreadsheet from the user, so the spreadsheet 

presents itself as a so-called application, or Decision Support 

System (DSS), via a custom-designed user interface, for example, a stock 

analyzer, or in general, as a design tool that asks the user questions and 

provides answers and reports. 

In a more elaborate realization, an Excel application can automatically poll 

external databases and measuring instruments using an update 

schedule, analyze the results, make a Word report or PowerPoint slide 

show, and e-mail these presentations on a regular basis to a list of 

participants. Excel was not designed to be used as a database. 

14.2. Features of Excel Sheet 

1. Add header and footer 

MS Excel allows us to keep the header and footer in our spreadsheet 

document. 

2. Find and replace command 

MS Excel allows us to find the needed data (text and numbers) in the 

workbook and  also replace the existing data with a new one. 

3. Password protection 

This feature of MS Excel allows the user to protect their workbooks by 

using a  password from unauthorized access to their information. 

4. Data filtering 

Filtering is a quick and easy way to find and work with a subset of data 

https://en.wikipedia.org/wiki/Visual_Basic_for_Applications
https://en.wikipedia.org/wiki/Microsoft_Office
https://en.wikipedia.org/wiki/Pivot_table
https://en.wikipedia.org/wiki/PivotTable
https://en.wikipedia.org/wiki/Data_analysis
https://en.wikipedia.org/wiki/Microsoft_Word
https://en.wikipedia.org/wiki/Microsoft_PowerPoint
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in a range. A  filtered range displays only the rows that meet the criteria 

you specify for a column. MS Excel provides two commands for filtering 

ranges: 

 AutoFilter; which includes filter by selection, for simple criteria 

 Advanced Filter; for more complex criteria 

5. Data sorting 

Data sorting is the process of arranging data in some logical order. MS 

Excel allows us to sort data either in ascending or descending order. 

6. Built-in formulae 

MS Excel has got many built-in formulae for sum, average, minimum, 

etc. We can use those formulae as per our needs. 

7. Create different charts (Pivot Table Report) 

MS Excel allows us to create different charts such as bar graph, pie- 

charts, line graphs, etc. This helps us to analyze and compare data very 

easily. 

8. Automatically edits the result 

MS Excel automatically edits the result if any changes are made in any 

of the cells. 

9. Formula auditing 

Using formula auditing feature of MS Excel, we can graphically display 

or trace the relationships between cells and formulas with blue arrows. 

We can trace the precedents (the cells that provide data to a specific 

cell) or the dependents (the cells that depend on the value in a specific 

cell) 

14.3. Excel sheet creation 

The Spreadsheet is the grid-based files designed to manage or perform 

any type of calculation on personal or business data. It is available in MS 

office as well as Office 365, from where a user can create a preadsheet. 

Here MS office is an on-premise application where Office 365 is based on 

the cloud. There are 400+ functions and many features like pivot, coloring, 

graph, chart, conditional formatting, and many more, making it the best 

choice for the users. 

The workbook is the Excel lingo for ‘spreadsheet’. MS Excel uses this 
term to emphasize that a single workbook can contain multiple 

worksheets where each one can have its own data grid, chart, or graph. 
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Example #1 – How to Create Spreadsheet in Excel? 

Step 1: Open MS Excel. 

Step 2: Go to Menu and select New >> click on the Blank workbook to 

create a simple worksheet. 

OR – Just press Ctrl + N: To create a new spreadsheet. 

Step 3: By default, Sheet1 will be created as a worksheet in the 

spreadsheet, and the name of the spreadsheet will be given as Book1 if 

you are opening it for the first time. 

 Basic App Functions Area: There is a green banner which 

contains all type of action to perform on the worksheet like save 

the file, back or front step move, new, undo, redo and many more. 

 Ribbon Area: There is a grey area just below the basic app 

functions area called Ribbon. It contains data manipulation, data 

visualizing toolbar, page layout tools, and many more. 

 Spreadsheet Work Area: By default, a grid containing alphabetic 

column A, B, C, …, Z, ZA…, ZZ, ZZA… and rows as Numbers 1,2 
3, …. 100, 101, … so on. It is a cell where the user can perform 
his calculation for personal or business data. Each rectangle box 

in the spreadsheet is called cell-like selected on the above 

screenshot is cell A1. 

 Formula Bar: It will show the data in the selected cell; if it contains 

any formula, it will show here. Like the above area, a search bar 

is available on the top right corner and a sheet tab which is 

available on the downside of the worksheet. A user can change 

the name of the sheet name. 

14.4. Summary  

The Spreadsheet is the grid-based files designed to manage or perform 

any type of calculation on personal or business data. 

In addition, it can display data as line graphs, histograms and charts, 

and with a very limited three-dimensional graphical display. 
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14.5. Keywords 

Excel sheet, Insert formula, Page layout and element 

14.6. Terminal Questions 

1. How to create spread sheet? 

2. Write the advantage of spread sheet. 

3. Define to write a macro program. 

4. What are the properties available in spread sheet? 

5. How the formula insert into sheet? 

Let Us Sum Up 

In this unit you have learned the followings: 

 Creating documents are business system  

 Program is set of coding or source code that will fulfil the user need 

or user expectation. 

 Input and output are insert data and display a result. 

Check your Progress 

1.  MS-Excel sheet contain   ___________ 

2.  Cell is intersect point of _____ and ______ 

3.  The row values are started from _____ 

4.  The column values are started form _______ 

Glossary 

Program :  The set of instruction is called program. 

Data :  used to construct program  

Input :  used to raw material 

Output :  To display the result or value 
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Answer to Check your Progress 

1. Cell 

2. Row and Column 

3. Number value 1,2,3,… 

4. Alphabetical A1, B1 ….. 

Suggested Reading 

1. H N Tiwari and Hem Chand Jain (2020), Computer Applications in 

Business CBCS (Choice Based Credit System), 6th Edition, Taxmann 

Publications. 

2. Dr. Sandeep Srivastava, Dr. Mirza Shab Shah, Er. Meera Goyal (2021), 

Computer Applications in Business (Latest Edition), 1st Edition, SBPD 

Publications. 

3. Er. Meera Goyal, Dr. Sandeep Srivastava (2022), Computer 

Applications in Business, 1st  Edition , SBPD Publications. 

 

 

 

 

  

https://www.flipkart.com/books/er-meera-goyal~contributor/pr?sid=bks
https://www.flipkart.com/books/dr-sandeep-srivastava~contributor/pr?sid=bks
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Unit-15 
Formatting the Worksheet 

STURCTURE 

Overview 

Objectives 

15.1. Formatting of Excel sheet 

15.2. Editing of Excel Sheet 

15.3. Organizing the worksheet 

15.4. Summary 

15.5. Keywords 

15.6. Terminal Questions 

Let us Sum up 

Check your progress 

Glossary 

Answer to check your progress 

Suggested Reading 

Overview  

In this unit the learners will learn and study about the basic functionality 

of Formatting of Excel sheet , Editing of Excel Sheet  and Organizing the 

worksheet. 

Objectives  

After completion of this unit, you will be able to: 

 Describe the purpose computer devices 

 Identify the roles, skills and functions of computer functionality  

 To clear idea of computer utilizations. 

 To understand the concept of Format command in excel sheet 

 To understand the working principle of excel sheet. 

 To understand the working principle of organizing worksheet. 

15.1. Formatting of Excel sheet 

The Stats Direct workbook supports a rich set of data formatting 

capabilities. You can use number formats to display numbers in a certain 

way - as dates, for example, or as scientific format numbers. You can use 

cell formats to change the size of cells and to add colours and borders. 
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You can use font formats to change the typeface and style of the 

characters in your worksheet. 

Using Built-in Number Formats 

Number formats determine how numbers look when they appear in the 

worksheet. When you create a new worksheet, by default all cells in that 

worksheet use the General format, which means that as you enter data in 

the worksheet, Stats Direct determines the type of data and applies the 

appropriate number format (e.g., if you enter a date, a date format is 

applied). 

 To specify formats other than General, you can apply a number of built-

in number formats. If you do not find the number format you want, you can 

create your own custom number format. 

To apply number formats: 

1. Select the cells for which you want to change the number format. 

2. Select Format Cells and select the Number tab. 

3. Select a category for the number format from the Category list. 

4. Type a number format or select a format type from the Type 

combo box. 

5. You can type a built-in format or a custom format. 

15.2. Editing of Excel sheet 

When you create a new worksheet, Discoverer applies a default format 

(e.g. colors, fonts) to worksheet items. For more information about 

changing the default format that is applied to worksheet items. 

Discoverer's powerful layout tools enable you to format worksheets 

exactly how you want them. For example, you might want to: 

 add items to a worksheet 

 remove items from a worksheet 

 change the color of rows and columns 

 change the background color or title of worksheets 

 change the format of text and numbers 

 change the column width on table worksheets (Discoverer 

automatically sets the column size on crosstab worksheets) 

You can edit worksheets using any of the following methods: 
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 by dragging and dropping a worksheet item from one area of a 

worksheet to another area (you can also resize worksheet 

columns using drag and drop) 

 by right-clicking on any area of a worksheet (e.g. a graph, 

worksheet item, worksheet item heading) to display a list of options 

for that area. 

 by using the Edit Worksheet wizard  

You edit a worksheet to change the way that the worksheet looks 

or behaves. For example, you might want to change the layout of 

worksheet data, or add calculations, percentages, or totals. 

To edit a worksheet using the Edit Worksheet Wizard: 

1. Display the worksheet that you want to edit. 

2. Choose Edit | Worksheet... to display the "Edit Worksheet dialog". 

3. The tabs on the Edit Worksheet dialog enable you to edit the 

properties of the current worksheet, as follows: 

4. use the Worksheet Layout tab to select the worksheet elements 

(e.g. title area, graph) to display on the worksheet (for more 

information, see "Edit Worksheet dialog: Worksheet Layout tab") 

5. use the Select Items tab to specify which items to display on the 

current worksheet (for more information, see "Edit Worksheet 

dialog: Select Items tab") 

6. use the Crosstab/Table Layout tab to change the layout of the 

current worksheet (for more information, see "Edit Worksheet 

dialog: Crosstab Layout tab" or "Edit Worksheet dialog: Table 

Layout tab") 

7. use the Sort tab to change the sort order of items on the current 

table worksheet (e.g. title area, graph) to display on the worksheet 

(for more information, see "Edit Worksheet dialog: Sort tab") 

8. Note: The Sort tab is only displayed for table worksheets. To sort 

a crosstab worksheet, Choose Tools | Sort to display the "Sort 

Crosstab dialog" (for more information, see "How to sort data on a 

crosstab worksheet"). 

9. use the Parameters tab to manage existing parameters and create 

new parameters (for more information, see "Edit Worksheet 

dialog: Parameters tab") 

https://docs.oracle.com/cd/B14099_19/bi.1012/b13915/dialog_reference.htm#i1020718
https://docs.oracle.com/cd/B14099_19/bi.1012/b13915/dialog_reference.htm#i1021203
https://docs.oracle.com/cd/B14099_19/bi.1012/b13915/dialog_reference.htm#i1021203
https://docs.oracle.com/cd/B14099_19/bi.1012/b13915/dialog_reference.htm#i1020796
https://docs.oracle.com/cd/B14099_19/bi.1012/b13915/dialog_reference.htm#i1020796
https://docs.oracle.com/cd/B14099_19/bi.1012/b13915/dialog_reference.htm#i1021424
https://docs.oracle.com/cd/B14099_19/bi.1012/b13915/dialog_reference.htm#i1021424
https://docs.oracle.com/cd/B14099_19/bi.1012/b13915/dialog_reference.htm#i1021343
https://docs.oracle.com/cd/B14099_19/bi.1012/b13915/dialog_reference.htm#i1025748
https://docs.oracle.com/cd/B14099_19/bi.1012/b13915/dialog_reference.htm#i1025748
https://docs.oracle.com/cd/B14099_19/bi.1012/b13915/sorting.htm#i1009115
https://docs.oracle.com/cd/B14099_19/bi.1012/b13915/sorting.htm#i1009115
https://docs.oracle.com/cd/B14099_19/bi.1012/b13915/dialog_reference.htm#i1021058
https://docs.oracle.com/cd/B14099_19/bi.1012/b13915/dialog_reference.htm#i1021058
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10. Click OK to save changes you have made and return to the 

worksheet. 

11. Discoverer updates the worksheet with the changes that you 

specified. 

15.3. Organizing the worksheet 

Microsoft Excel is a program that uses spreadsheets to help you organize 

numbers and data with functions and formulas. There are many different 

ways you can use Excel, and with so many ideas, it is easy to get 

disorganized. 

With that said, there is always a way to find a workaround that will help 

you get your spreadsheets in order. This is especially useful for team 

projects in Excel. 

 

1. Use Templates 

You should not waste your time trying to recreate Excel spreadsheets 

from scratch every time you want to analyze your data. Instead, Microsoft 

Excel already includes a wide range of user-made templates. 

Simply click on File > New and choose one of the many templates that 

come with Excel. Of course, you might have difficulty finding a template 

that perfectly suits your data analysis process. 

But, you can still find one, which you can easily format to make it look 

better and more functional. 

2. Highlight the Important Data 

As with any management tool, you should always highlight the most 

important information. The same applies when you are working in Excel, 

especially if you have a whole team working in a single spreadsheet. 

https://www.makeuseof.com/tag/10-amazingly-useful-spreadsheet-templates-organise-life/
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One of the easiest ways you can do this is to create a dashboard sheet 

where your key data points will be summarized. 

3. Sort Your Data 

One of the integral parts of data analysis is knowing how to sort your data. 

No matter whether you want to sort the names alphabetically or list the 

products from lowest to the highest price, it doesn't matter how you do it. 

Sorting your data will help you quickly understand and visualize your data 

better. Excel allows you to sort your data alphabetically, numerically, and 

by date and time. You can also choose to sort it by a custom list that you 

create, or by formatting, font color, icon set, or by including cell color. 

4. Use Multiple Sheets! 

When you are working on something complex or working with a lot of 

information overall, do not forget that Excel allows you to simultaneously 

use many spreadsheets. 

You do not have to store all your information on a single spreadsheet. 

Instead, spread your data across multiple spreadsheets and label it 

accordingly. This will allow you to find all the info that you need easily. 

5. Hide Unnecessary Data 

When you have too much information in a spreadsheet, it is difficult to 

focus on the right things. If you find yourself getting lost in numbers, 

maybe it is time to review your spreadsheets, component by component. 

If you find any type of information that doesn't seem necessary or 

important anymore, you can hide it. Excel has a feature that lets you hide 

columns, sheets, or rows that you no longer require, but don't want to 

delete. 

6. Hyperlinked Cells Can Save You a Lot of Time 

When working in a team, or even alone, more often than not, you will 

waste time searching for a certain piece of information, by going through 

all the spreadsheets. 

But, it does not have to be that way. Instead, you can name your important 

cells and hyperlink them within your sheets, which will guide you through 

the data. Microsoft Excel has great navigation tools for your data analysis, 

so make sure to utilize  
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7. Use Formulas and Functions Correctly 

Mastering the basics of Excel formulas is critical for all beginners. 

Microsoft Excel is considered as the software for data analysis, across 

most industry standards. 

It also happens to be the most preferred software for financial analysts, 

investment bankers, presentations, and financial modeling. 

8. Shortcuts Can Help You Work Faster 

Once you are already used to Excel functions and formulas, you should 

learn the basic shortcuts. You might find that by using keyboard shortcuts 

for Excel, you will be able to work a lot more efficiently. 

This especially applies to users with mobility or vision disabilities. 

Keyboard shortcuts are an easier way to get the results you want from 

Excel without tapping on a touchscreen or using a mouse. 

15.4. Summary 

To learn and use cell formats to change the size of cells and to add colours 

and borders.  

To learn about use of font formats to change the typeface and style of the 

characters in your worksheet. 

15.5. Keywords 

Cell, Format, font, Sort, hyperlink and functions 

15.6. Terminal Questions 

1. What is meant by cell? 

2. How the data value insert into cell? 

3. What are the advantage of cell? 

Let us Sum Up 

In this unit you have learned the followings: 

 Creating documents are business system  

 Program is set of coding or source code that will fulfil the user need 

or user expectation. 

 Input and output are insert data and display a result. 
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Check your Progress 

1.  MS-Excel formatting are    ___________ types  

2.  Alignment of text in ________ side  

3.  The number values always placed in _____ side 

4.  Del key used to particular _________. 

Glossary 

Program :  The set of instruction is called program. 

Data :  used to construct program  

Input :  used to raw material 

Output :  To display the result or value 
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Answer to Check your Progress 

1. Three 

2. Left 

3. Right 

4. Data 

Suggested Reading 

1. H N Tiwari and Hem Chand Jain (2020), Computer Applications in 

Business CBCS (Choice Based Credit System), 6th Edition, Taxmann 

Publications. 

2. Dr. Sandeep Srivastava, Dr. Mirza Shab Shah, Er. Meera Goyal (2021), 

Computer Applications in Business (Latest Edition), 1st Edition, SBPD 

Publications. 

3. Er. Meera Goyal, Dr. Sandeep Srivastava(2022), Computer 

Applications in Business , 1st  Edition , SBPD Publications. 

  

https://www.flipkart.com/books/er-meera-goyal~contributor/pr?sid=bks
https://www.flipkart.com/books/dr-sandeep-srivastava~contributor/pr?sid=bks
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Unit-16 
Formulas and Functions 

STURCTURE 

Overview 

Objectives 

16.1. Sheet using formulas and functions 

16.2. Worksheet data sorting and filtering 

16.3. Summary 

16.4. Keywords 

16.5. Terminal Questions 

Let us Sum up 

Check your progress 

Glossary 

Answer to check your progress 

Suggested Reading 

Overview  

In this unit the learners will learn and study about the basic functionality 

of Sheet using formulas and functions and Worksheet data sorting and 

filtering. 

Objectives  

After completion of this unit, you will be able to: 

 Describe the purpose computer devices 

 Identify the roles, skills and functions of computer functionality  

 To clear idea of computer utilizations. 

 To understand the concept of sorting data items. 

 To understand the working principle of formulas and function 

 To develop the program for sorting and filtering in excel sheet. 

16.1 Sheet using formulas and functions 

 Formula is an expression that calculates values in a cell or in a 

range of cells. 

For example, =A2+A2+A3+A4 is a formula that adds up the values in 

cells A2 through A4. 
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 Function is a predefined formula already available in Excel. 

Functions perform specific calculations in a particular order based 

on the specified values, called arguments, or parameters. 

For example, instead of specifying each value to be summed like in the 

above formula, you can use the SUM function to add up a range of 

cells: =SUM(A2:A4) 

 

Excel basic functions you should definitely know 

What follows below is a list of 10 simple yet really helpful functions that 

are a necessary skill for everyone who wishes to turn from an Excel novice 

to an Excel professional. 

SUM 

The first Excel function you should be familiar with is the one that performs 

the basic arithmetic operation of addition: 

SUM(number1, [number2], …) 

In the syntax of all Excel functions, an argument enclosed in [square 

brackets] is optional, other arguments are required. Meaning, your Sum 

formula should include at least 1 number, reference to a cell or a range of 

cells. For example: 

=SUM(B2:B6) - adds up values in cells B2 through B6. 

=SUM(B2, B6) - adds up values in cells B2 and B6. 

If necessary, you can perform other calculations within a single formula, 

for example, add up values in cells B2 through B6, and then divide the 

sum by 5: 

=SUM(B2:B6)/5 
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To sum with conditions, use the SUMIF function: in the 1st argument, 

you enter the range of cells to be tested against the criteria (A2:A6), in 

the 2nd argument - the criteria itself (D2), and in the last argument - the 

cells to sum (B2:B6): 

=SUMIF(A2:A6, D2, B2:B6) 

In your Excel worksheets, the formulas may look something similar to 

this: 

 

AVERAGE 

The Excel AVERAGE function does exactly what its name suggests, i.e. 

finds an average, or arithmetic mean, of numbers. Its syntax is similar to 

SUM's: 

AVERAGE (number1, [number2], …) 

Having a closer look at the formula from the previous section 

(=SUM(B2:B6)/5), what does it actually do? Sums values in cells B2 

through B6, and then divides the result by 5. And what do you call adding 

up a group of numbers and then dividing the sum by the count of those 

numbers? Yep, an average! 

The Excel AVERAGE function performs these calculations behind the 

scenes. So, instead of dividing sum by count, you can simply put this 

formula in a cell: 

=AVERAGE(B2:B6) 

To average cells based on condition, use the following AVERAGEIF 

formula, where A2:A6 is the criteria range, D3 is he criteria, and B2:B6 

are the cells to average: 

=AVERAGEIF(A2:A6, D3, B2:B6) 
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MAX & MIN 

The MAX and MIN formulas in Excel get the largest and smallest value 

in a set of numbers, respectively. For our sample data set, the formulas 

will be as simple as: 

=MAX(B2:B6) 

=MIN(B2:B6) 

 

COUNT & COUNTA 

If you are curious to know how many cells in a given range 

contain numeric values (numbers or dates), don't waste your time 

counting them by hand. The Excel COUNT function will bring you the 

count in a heartbeat: 

COUNT(value1, [value2], …) 

While the COUNT function deals only with those cells that contain 

numbers, the COUNTA function counts all cells that are not blank, 

whether they contain numbers, dates, times, text, logical values of TRUE 

and FALSE, errors or empty text strings (""): 

COUNTA (value1, [value2], …) 

For example, to find out how many cells in column B contain numbers, 

use this formula: 

=COUNT(B:B) 

To count all non-empty cells in column B, go with this one: 

=COUNTA(B:B) 

In both formulas, you use the so-called "whole column reference" (B:B) 

that refers to all the cells within column B. 

The following screenshot shows the difference: while COUNT processes 

only numbers, COUNTA outputs the total number of non-blank cells in 

column B, including the text value in the column header. 
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IF statement  

Judging by the number of IF-related comments on our blog, it's the most 

popular function in Excel. In simple terms, you use an IF formula to ask 

Excel to test a certain condition and return one value or perform one 

calculation if the condition is met, and another value or calculation if the 

condition is not met: 

IF(logical_test, [value_if_true], [value_if_false]) 

For example, the following IF statement checks if the order is completed 

(i.e. there is a value in column C) or not. To test if a cell is not blank, you 

use the "not equal to" operator ( <>) in combination with an empty string 

(""). As the result, if cell C2 is not empty, the formula returns "Yes", 

otherwise "No": 

=IF(C2<>"", "Yes", "No") 

 

16.2. Working data sorting and filtering 

Excel offers additional sorting options, including sorting by custom lists. 

Custom lists are useful when you want a user-defined order that doesn’t 
follow existing sort rules. For example, you can’t use an alphabetical sort 
to sort the values High, Medium, and Low. If you create your own custom 

list, you can specify the values you want to sort by, in the order you want 

to sort them. 

To sort data in Excel: 

1. Select a cell in the column you want to sort. 
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2. In the Data tab, go to the Sort & Filter group. Then you have two 

options. 

1. To sort values in ascending or descending order based 

on Excel’s interpretation of the column, click the Sort A to 

Z or Sort Z to A icons. 

2. For more sorting options, click the Sort button. You can 

then specify the Column, what to Sort On, and Order. 

With the Add Level option, you can perform a secondary 

level of sorting if needed. 

Filtering data in Excel 

You can use filters to temporarily hide some of the data in a table, so you 

can focus on the data you want to see. When filtering, you can specify 

exact matches or comparisons (‘more than’, ‘less than’) or data that 
doesn’t match specific criteria. The following comparison operators are 
available in Excel. You can compare two values by using the following 

operators. When you use these operators to compare two values, the 

result is a logical value—it’s either TRUE or FALSE. 

Comparison 

operator 
Meaning Example 

Result (A1=1, 

B1=2) 

= Equal to A1=B1 FALSE 

> Greater than A1>B1 FALSE 

< Less than A1<B1 TRUE 

>= 
Greater than 

or equal to 
A1>=B1 FALSE 

<= 
Less than or 

equal to 
A1<=B1 TRUE 

<> Not equal to A1<>B1 TRUE 
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To create a filter in Excel: 

1. Select the data you want to work with. 

2. Select Data > Filter from the ribbon menu. 

3. At the top of your selection, select the column header arrow (grey 

box with downwards arrow). 

4. Select Text Filters or Number Filters, and then select a 

comparison, such  

 

5. Enter the filter criteria and select OK. 

  

For more complex filtering you can use logical operators such as AND 

and OR to select results—depending on which criteria evaluate to true. 

AND will only evaluate to true if both criteria evaluate to true (e.g. 1<2 

AND 3<4). OR evaluates to true if either criteria, or both, evaluate to true 

(e.g. 1<2 OR 3>4 would evaluate as TRUE). 

 

16.3. Summary 

Excel offers additional sorting options, including sorting by custom lists. 

Custom lists are useful when you want a user-defined order that doesn’t 
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follow existing sort rules. For example, you can’t use an alphabetical sort 

to sort the values High, Medium, and Low. 

16.4. Keywords 

Formula, function, sum, min and max 

16.5. Terminal Questions 

1. How the data values are sorted? 

2. What is meant by filtering? 

3. Write the query of min and max function. 

4. Explain about sum function. 

5. Write a short not formatting. 

Let us Sum Up 

In this unit you have learned the followings: 

 Creating documents are business system  

 Program is set of coding or source code that will fulfil the user need 

or user expectation. 

 Input and output are insert data and display a result. 

Check your Progress 

1.  MS-Excel to construct student   ___________ 

2.  The auto sum symbol sigma (E) is  ____________ 

3.  The average calculation based on   ________ 

4.  The student results are Pass or Fail how will produce _____. 

Glossary 

Program :  The set of instruction is called program. 

Data :  used to construct program  

Input :  used to raw material 

Output :  To display the result or value 
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Answer to Check your Progress 

1. Data base 

2. Total value of particular row or column  

3. Cell value 

4. IF Condition 

Suggested Reading 

1. H N Tiwari and Hem Chand Jain (2020), Computer Applications in 

Business CBCS (Choice Based Credit System), 6th Edition, Taxmann 

Publications. 

2. Dr. Sandeep Srivastava, Dr. Mirza Shab Shah, Er. Meera Goyal (2021), 

Computer Applications in Business (Latest Edition), 1st Edition, SBPD 

Publications. 

3. Er. Meera Goyal, Dr. Sandeep Srivastava(2022), Computer 

Applications in Business, 1st  Edition , SBPD Publications. 

  

https://www.flipkart.com/books/er-meera-goyal~contributor/pr?sid=bks
https://www.flipkart.com/books/dr-sandeep-srivastava~contributor/pr?sid=bks
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Unit-17 
Creating Charts 

STURCTURE 

Overview 

Objectives 

17.1. Creating charts using Excel 

17.2. Print and review command using excel 

17.3. Summary 

17.4. Keywords 

17.5. Terminal Questions 

Let us Sum up 

Check your progress 

Glossary 

Answer to check your progress 

Suggested Reading 

Overview  

In this unit the learners will learn and study about the Creating charts using 

Excel and Print and review command using excel. 

Objectives  

After completion of this unit, you will be able to: 

 Describe the purpose computer devices 

 Identify the roles, skills and functions of computer functionality  

 To clear idea of computer utilizations. 

 To understand the concept of chart using excel 

 To understand the working principle of print and print view 
command 

17.1. Creating Charts using Excel 

Charts help you visualize your data in a way that creates maximum impact 

on your audience. Learn to create a chart and add a trend line. You can 

start your document from a recommended chart or choose one from our 

collection of pre-built chart templates. 

1. Select the data for which you want to create a chart. 

2. Click INSERT > Recommended Charts. 

https://go.microsoft.com/fwlink/p/?linkid=2171129
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3. On the Recommended Charts tab, scroll through the list of charts 

that Excel recommends for your data, and click any chart to see 

how your data will look. ... 

4. When you find the chart you like, click it > OK. 

 

17.2. Print and review command using Excel 

1. Click the chart within your workbook. 

2. Click File > Print. Tip: You can also use the keyboard shortcut, 

Ctrl + P, to open the Print option. 

3. Click the Printer drop-down menu, and select the printer you 

want to use. 

4. Click Print. 

17.3. Summary 

Charts help you visualize your data in a way that creates maximum impact 

on your audience. Learn to create a chart and add a trend line. 

17.4. Keywords 

Charts, Graph, print and print preview. 

17.5. Terminal Questions 

1. What is the use of chart? 

2. How to construct chart? 

3. What is legand? 

4. How to format chart and also write the different types of chart. 
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Let us Sum Up 

In this unit you have learned the followings: 

 Creating documents are business system  

 Program is set of coding or source code that will fulfil the user need 

or user expectation. 

 Input and output are insert data and display a result. 

Check your Progress 

1.  Table value mean _____ and ____ Value 

2.  Chart is based on _______ 

3.  The types charts are _____  , ______ 

4.  Chart in how many types available based on dimension _____. 

Glossary 

Program :  The set of instruction is called program. 

Data :  used to construct program  

Input :  used to raw material 

Output :  To display the result or value 
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Answer to Check your Progress 

1. Row and column  

2. Table value  

3. Bar chart and Pie chart 

4. Three types  

Suggested Reading 

1. H N Tiwari and Hem Chand Jain (2020), Computer Applications in 

Business CBCS (Choice Based Credit System), 6th Edition, Taxmann 

Publications. 

2. Dr. Sandeep Srivastava, Dr. Mirza Shab Shah, Er. Meera Goyal (2021), 

Computer Applications in Business (Latest Edition), 1st Edition, SBPD 

Publications. 

3. Er. Meera Goyal, Dr. Sandeep Srivastava (2022), Computer 

Applications in Business, 1st Edition , SBPD Publications. 

 

 

 

  

https://www.flipkart.com/books/er-meera-goyal~contributor/pr?sid=bks
https://www.flipkart.com/books/dr-sandeep-srivastava~contributor/pr?sid=bks
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Block-5:  Introduction  

The Block-5: Microsoft PowerPoint has been divided into three Units 

(Unit-18 to Unit-20). 

Unit-18: Microsoft PowerPoint Introduction deals with the History of 

Microsoft PowerPoint and MS-PPT history and versions. 

Unit-19: Features of PowerPoint explains about Features of PowerPoint 

such as File Creation, Slide Creation and Formatting. 

Unit-20: Editing and Animation describes about the Editing, Adding 

Transitions and Animation, Print Review and Printing in PowerPoint. 

In all the units of Block -5: Microsoft PowerPoint, the Check your 

progress, Glossary, Answers to Check your progress and Suggested 

Reading has been provided and the Learners are expected to attempt all 

the Check your progress as part of study.  
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Unit-18 
Microsoft PowerPoint Introduction 

STURCTURE 

Overview 

Objectives 

18.1. Microsoft PowerPoint 

18.2. MS-PPT history and versions 

18.3. Summary  

18.4. Keywords 

18.5. Terminal Questions 

Let us Sum up 

Check your progress 

Glossary 

Answer to check your progress 

Suggested Reading 

Overview  

In this unit the learners will learn and study about the basic functionality 

of Microsoft PowerPoint and MS-PPT history and versions. 

Objectives  

After completion of this unit, you will be able to: 

 Describe the purpose computer devices 

 Identify the roles, skills and functions of computer functionality  

 To clear idea of computer utilizations. 

 insert a new slide in your presentation,  

 explain different slide views,  

 insert graphs and diagrams in slides,  

 insert pictures in slides,  

 insert sound and video in slides, and  

 copy presentation in Pen Drive/Compact Disc (CD). 
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18.1. Microsoft PowerPoint 

A PowerPoint is a software from Microsoft, which is used to create 

presentation. Generally, a presentation is created by logical collection of 

individual slides that contain information on a specific topic. PowerPoint 

is used for preparing range of presentations on various topics including 

educational presentation, business presentation, social awareness 

presentations etc.  

PowerPoint allows us to add different elements such as images, and 

audio/visual features in our presentation. These elements are called 

Multimedia Element. To make a multimedia presentation, we should use 

at least one of the following elements: Image, Audio, Video, and 

Animation. In this unit, you will learn working on PowerPoint. Also, you will 

learn how to use different multimedia elements in your presentations to 

make it more informative and effective. 

PowerPoint Basics- Inserting a New Slide  

When you make PowerPoint presentation, sometimes need arises to 

insert a slide between two slides to add some text, image or other 

multimedia components. To insert a new slide into a presentation, one of 

the following three ways may be used:  

1) Using the New Slide tab of Home Menu to insert slide  

2) Using shortcut key “CTRL+M” to insert a slide  

3) Clicking at space between two sides where new slide to be inserted 

and then by pressing Mouse Right-Button and click on new slide option to 

insert slide, you may insert a slide. 

 Let us see how we may use these three options for inserting new slide in 

a presentation. Using the New Slide tab of Home Menu 
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Slide Views  

In the below figure , if you want to insert a slide between slide-2 and slide-

3 then click between slide-2 and slide-3 then, insert the new slide using 

any of the three options given above.  

 

 Inserting slide using Mouse right click 

Microsoft PowerPoint has the following views, which can be used at 

different point of time for different purpose during preparation, 

modification, slide presentation and printing:  

 Normal View  

 Slide Sorter View  

 Notes Page View  

 Slide Show View  

 Slide Master View  

 Handout Master  

 Notes Master View 

 

While using PowerPoint Presentation, you can quickly switch between 

views by clicking on the view icons.  

Normal View: It is the main editing view, which is used to write and design 

a presentation. Normal view displays slide thumbnails on the left, a large 

window showing the current slide, in which you do the content insertion or 

editing. 
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Slide Sorter View: This view displays all the slides in your presentation in 

horizontal sequenced. This view helps in selecting your slides and 

readjusting their positions in your presentation. You can just click and drag 

your slides to a new location and make meaningful grouping of the slides 

in your presentation. In Slide Sorter View, you cannot edit the contents of 

a slide. You have to switch to Slide View, where you can edit the contents. 

 

Notes Page View: The notes page is located below the slide window. This 

allows you to write some points as notes on that specific slide. You can 

print your notes for reference or also you can give notes to the audience. 

You can also use notes while you are making presentation of your slides. 

 

Slide Master View: This view includes Slide, Handout, and Notes. 

Advantage of working in a master view is that you can make universal 

style changes to every slide, notes page, or handout associated with your 

presentation. When you want all your slides to contain the same fonts and 
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images, you need to change those in one place (in the Slide Master) and 

the changes will be applied to all your slides. 

 

You change and manage slide layouts in Slide Master View. Every theme 

has a several slide layouts. Some layouts are better for text and some are 

better for graphics. You have to choose the layouts which are suitable for 

your slide content.  

18.2. History and versions 

On April 20, 1987, the first version of PowerPoint was released. Because 

we love the software so much (and we know many of you readers do, 

too!), we wanted to celebrate PowerPoint’s 33rd birthday with a whole 
article dedicated to its origins, history, and use cases! 95% of 

presentations are created with PowerPoint, 30 Million PowerPoint 

presentations are given every day, and 500 million people all over the 

world are using the software. So without further ado, let’s dive into the 

success story of PowerPoint - with the early beginnings and the 

development throughout the different versions 

18.3. Summary 

A PowerPoint is a software from Microsoft, which is used to create 

presentation. Generally, a presentation is created by logical collection of 

individual slides that contain information on a specific topic. 

18.4. Keywords 

PowerPoint inserts, delete, show and slide. 

18.5 Terminal Questions 

1. What is use of power point? 

2. What are the advantages of power point? 

3. Write about slide show and view. 

4. Write about transition. 

5. How the image and picture insert into PowerPoint? 
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Let us Sum Up 

In this unit you have learned the followings: 

 Creating documents are business system  

 Program is set of coding or source code that will fulfil the user need 

or user expectation. 

 Input and output are insert data and display a result. 

Check your Progress 

1.  PowerPoint is used to    ___________ 

2.  PowerPoint is based on ________  

3.  PowerPoint is add table is __________ 

4.  Table and Image are __________ in slide is possible. 

Glossary 

Program :  The set of instruction is called program. 

Data :  used to construct program  

Input :  used to raw material 

Output :  To display the result or value 
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Answer to Check your Progress 

1. Deliver summery in short form  

2. Slide  

3. Possible in slide 

4. Insert  

Suggested Reading 

1. H N Tiwari and Hem Chand Jain (2020), Computer Applications in 

Business CBCS (Choice Based Credit System), 6th Edition, Taxmann 

Publications. 

2. Dr. Sandeep Srivastava, Dr. Mirza Shab Shah, Er. Meera Goyal (2021), 

Computer Applications in Business (Latest Edition), 1st Edition, SBPD 

Publications. 

3. Er. Meera Goyal, Dr. Sandeep Srivastava (2022), Computer 

Applications in Business, 1st  Edition , SBPD Publications. 

 

 

  

https://www.flipkart.com/books/er-meera-goyal~contributor/pr?sid=bks
https://www.flipkart.com/books/dr-sandeep-srivastava~contributor/pr?sid=bks
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Unit-19 
Features of PowerPoint  

STURCTURE 

Overview 

Objectives 

19.1. PPT file creation 

19.2. Slide creation 

19.3. Formatting of slide 

19.4. Summary 

19.5. Keywords 

19.6. Terminal Questions 

Let us Sum up 

Check your progress 

Glossary 

Answer to check your progress 

Suggested Reading 

Overview  

In this unit the learners will learn and study about the basic functionality 

of PPT file creation, Slide creation and  Formatting of slide. 

Objectives  

After completion of this unit, you will be able to: 

 Describe the purpose computer devices 

 Identify the roles, skills and functions of computer functionality  

 To clear idea of computer utilizations. 

 To understand slide show creation 

 To understand different types of transition to apply 

 To understand slide designing 

19.1. PPT file creation 

Create a presentation in PowerPoint 

With PowerPoint on your PC, Mac, or mobile device: 

 Create presentations from scratch or a template. 

 Add text, images, art, and videos. 
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 Select a professional design with PowerPoint Designer. 

 Add transitions, animations, and motion. 

 Save to OneDrive, to get to your presentations from your 

computer, tablet, or phone. 

 Share and work with others, wherever they are. 

Create a presentation 

1. Open PowerPoint. 

2. In the left pane, select New. 

3. Select an option: 

 To create a presentation from scratch, select Blank 

Presentation. 

 To use a prepared design, select one of the templates. 

 To see tips for using PowerPoint, select Take a Tour, and 

then select Create,  

Add a slide 

4. In the thumbnails on the left pane, select the slide you want your 

new slide to follow. 

5. In the Home tab, in the Slides section, select New Slide. 

6. In the Slides section, select Layout, and then select the layout you 

want from the menu. 

Add and format text 

7. Place the cursor inside a text box, and then type something. 

8. Select the text, and then select one or more options from 

the Font section of the Home tab, such as Font, Increase Font 

Size, Decrease Font Size, Bold, Italic, Underline, etc. 

9. To create bulleted or numbered lists, select the text, and then 

select Bullets or Numbering. 

19.2. Slide Creation 

Add a picture, shape, and more 

1. Go to the Insert tab. 

2. To add a picture: 

 In the Images section, select Pictures. 
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 In the Insert Picture From menu, select the source you 

want. 

 Browse for the picture you want, select it, and then 

select Insert. 

3. To add illustrations: 

 In the Illustrations section, select Shapes, Icons, 3D 

Models, SmartArt, or Chart. 

 In the dialog box that opens when you click one of the 

illustration types, select the item you want and follow the 

prompts to insert it. 

19.3. Formatting of slide 

In the previous chapter, you learned how to massage text into perfectly 

indented paragraphs, columns, and lists. Now it’s time for the big picture. 
This chapter shows you how to format slide using layouts, and how to 

reapply a theme or colour scheme (a list of coordinating font colours). 

Finally and most important when you’re in a time crunch you’ll learn how 
to turn on PowerPoint’s automatic formatting options. 

 Apply canned layouts to your slides. You can tell PowerPoint to 

put a title at the top of a slide and two content placeholders (for 

text, pictures, and so on) side-by-side in the body of the slide. 

 Change orientation. You can change a landscape orientation 

(where the slide’s wider than it is tall) to a portrait orientation 

(where the slide’s taller than it is wide). 

 Reposition elements. You can drag text boxes and other objects 

(such as pictures) around on your slide to reposition them. 

Changing Background Colour 

 In most cases, you won’t want to change the background colour 

of your slides. Instead, you’ll rely on the professionally designed 
themes that ship with PowerPoint (and that you can find for free 

or purchase on the Web), which coordinate text and background 

colour and effects into an aesthetically pleasing package. 

 Of course, there’s an exception or two to every rule. In the case of 
background colour, one exception to the don’t-change-it rule is 

when you need to match your presentation to a specific (non-

PowerPoint) corporate or organizational palette, such as the one 

your Marketing department uses for brochures and four-color ads. 
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19.4. Summary 

This chapter shows you how to format slide using layouts, and how to 

reapply   theme or colour scheme  

19.5. Keywords 

Slide, text, format, view and show 

19.6. Terminal Questions 

1. How does the font changed in slide? 

2. What is slide show? 

3. What is slide transition? 

Let us Sum Up 

In this unit you have learned the followings: 

 Creating documents are business system  

 Program is set of coding or source code that will fulfil the user need 

or user expectation. 

 Input and output are insert data and display a result. 

Check your Progress 

1.  The combination of audio and video is called    ___________ 

2.  Slide show apply automatically based on _______ 

3.  Slide Transition are called _________ 

4.  Slide show is also added sound is ______. 

Glossary 

Program :  The set of instruction is called program. 

Data :  used to construct program  

Input :  used to raw material 

Output :  To display the result or value 
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Answer to Check your Progress 

1. Multimedia file  

2. Time  

3. To show in different ways  

4. Possible  

Suggested Reading 

1. H N Tiwari and Hem Chand Jain (2020), Computer Applications in 

Business CBCS (Choice Based Credit System), 6th Edition, Taxmann 

Publications. 

2. Dr. Sandeep Srivastava, Dr. Mirza Shab Shah, Er. Meera Goyal (2021), 

Computer Applications in Business (Latest Edition), 1st Edition, SBPD 

Publications. 

3. Er. Meera Goyal, Dr. Sandeep Srivastava (2022), Computer 

Applications in Business, 1st  Edition , SBPD Publications. 

  

https://www.flipkart.com/books/er-meera-goyal~contributor/pr?sid=bks
https://www.flipkart.com/books/dr-sandeep-srivastava~contributor/pr?sid=bks
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Unit-20 
Editing and Animation 

STURCTURE 

Overview 

Objectives 

20.1. Editing of Power point 

20.2. Adding Transition and animation in PowerPoint 

20.3. Print and review using PowerPoint 

20.4. Summary 

20.5. Keywords 

20.6. Terminal Questions 

Let us Sum up 

Check your progress 

Glossary 

Answer to check your progress 

Suggested Reading 

Overview  

In this unit the learners will learn and study about the Editing of Power 

point Adding Transition and animation in PowerPoint Print and review 

using PowerPoint. 

Objectives  

After completion of this unit, you will be able to: 

 Describe the purpose computer devices 

 Identify the roles, skills and functions of computer functionality  

 To clear idea of computer utilizations. 

 To understand the concept Editing of slide show. 

  To understand the concept of animation and image moving in 

slide. 

20.1. Editing of Power point 

Microsoft PowerPoint is part of the Microsoft Office Suite program library 

and is used to create slide presentations. To edit a PowerPoint 

presentation, it must be in PowerPoint format (.ppt or .pptx). For example, 

a presentation that has been converted to a QuickTime movie and is now 
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in .mov format, cannot be edited in PowerPoint. However, if you still have 

the original .ppt or .pptx file used to create the movie, you can edit that 

and create an updated movie. 

Step 1 

Open the PowerPoint file with your PowerPoint Software. Click the "New 

Slide" button at the top of the screen if you want to add a new slide to the 

presentation file. 

Step 2 

 

Slide Thumbnails 

Click the slide thumbnails along the left side of the screen to move to a 

specific slide you want to edit. 

Step 3 

Click the "Slide Sort View" button in the bottom left of the corner to view 

all your slides as thumbnails. Then, click and drag to rearrange the slide 

order. Click the "Slide Themes" button at the top of the screen if you want 

to change the colour theme for the entire presentation to something new. 

Step 4 

Selected Object 

Click slide objects to select them. Press delete if you want to remove a 

selected object. Use the formatting palette to change settings for a 

selected object. 

20.2. Adding Transition and animation in Power point 

Add Animations 

You can animate the objects on your PowerPoint slides. PowerPoint 

provides four types of animations: Entrance, Emphasis, Exit, and Motion 

Paths. An Entrance animation determines the manner in which an object 
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appears on a slide; for example, an object can move onto a slide. An 

Emphasis animation does something to draw attention to an object; for 

example, the object can become larger. An Exit animation determines the 

manner in which an object leaves a slide; for example, an object can move 

off a slide. A Motion Paths animation determines how an object moves 

around a slide; for example, an object can move from left to right. 

To choose an effect: 

1. Select the object you want to animate. 

2. Choose the Animations tab. 

3. Click the Custom Animation button . The 

Custom Animation pane appears. 

4. Click the Add Effect button . A menu appears. 

5. Choose the type of effect you want. A submenu appears. 

6. Click the effect you want. PowerPoint applies the effect. 

To modify an effect: 

1. Click the down arrow next to the Start field on the Custom 

Animations pane and then select the start method you want. 

2. Click the down arrow next to the Property field on the Custom 

Animations pane and the select the property you want. The 

Property field might be labeled Direction, Size, or some other 

property. 

3. Click the down arrow next to the Speed field on the Custom 

Animations pane and then select the speed you want to apply to 

your animation. 

To preview the animation, click the Play button  on the Custom 

Animations pane. 

20.3. Print and review using power point 

To preview your file, click Print Preview. To go back to your file and make 

changes before you print it, click the File tab again. To print your file and 

check or change the properties for your printer, click Print. To print your 

file without checking or changing the properties for your printer, click Quick 

Print. 

The Print Preview feature lets you see how your PowerPoint slides will 

appear before you print them. To use the PowerPoint Print Preview 

feature, choose Office— Print — Print Preview. Or you can click the 
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Preview button from the Print dialog box. Either way, a preview of the 

printed page appears. 

Print Your PowerPoint Poster- To print a poster: Go to File > Print. On a 

Mac, in the Print dialog box, check the print settings, select Scale to Fit 

Paper, and then select Print. Select Print Full Page Slides. 

20.4 .Summary 

The Print Preview feature lets you see how your PowerPoint slides will 

appear before you print them. 

20.5. Keywords 

File, button, animation, view and display 

20.6 Terminal Questions 

1. What is meant by effect in ppt? 

2. How does the ppt will display different method? 

3. What are the user of print command? 

Let us Sum up 

In this unit you have learned the followings: 

 Creating documents are business system  

 Program is set of coding or source code that will fulfil the user need 

or user expectation. 

 Input and output are insert data and display a result. 

Check your Progress 

1.  The DEL key is used to    ___________ 

2.  Adding table content in PowerPoint is _______ 

3.  Text colour and text size are arranged in PowerPoint is ______ 

4.  Adding animation is PowerPoint is _______ file . 
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Glossary 

Program :  The set of instruction is called program. 

Data :  used to construct program  

Input :  used to raw material 

Output :  To display the result or value 

Answer to Check your Progress 

1. Delete particular data  

2. Possible  

3. Editing  

4. Multimedia file  

Suggested Reading 

1. H N Tiwari and Hem Chand Jain (2020), Computer Applications in 

Business CBCS (Choice Based Credit System), 6th Edition, Taxmann 

Publications. 

2. Dr. Sandeep Srivastava, Dr. Mirza Shab Shah, Er. Meera Goyal (2021), 

Computer Applications in Business (Latest Edition), 1st Edition, SBPD 

Publications. 

3. Er. Meera Goyal, Dr. Sandeep Srivastava (2022), Computer 

Applications in Business, 1st  Edition, SBPD Publications. 

  

https://www.flipkart.com/books/er-meera-goyal~contributor/pr?sid=bks
https://www.flipkart.com/books/dr-sandeep-srivastava~contributor/pr?sid=bks
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Model End Semester Examination Question Paper 

Master of Business Administration (MBA) 

Course Code: DCMBA-17 

Course Title: Computer Applications for Business 

Max. Marks: 70                                                                    Time: 3 hours 

PART – A (10x2 =20 Marks) 

Answer any TEN questions out of TWELVE questions 

[All questions carry equal marks] 

1. List the main uses of computer  

2. Examine the role of memory management. 

3. List the three basic devices of computer. 

4. Justify the importance input devices. 

5. Predict the importance of output devices. 

6. Outline the diagram of computer systems. 

7. Explain the role of primary memory. 

8. Outline the importance central process unit. 

9. Categorize different types of computer systems 

10. Comment on shortcut keys in cut, copy and paste. 

11. Summarize the Advantages and Disadvantages of computer 

systems. 

12. Elaborate the generation of computers. 

PART – B (5X8=40 Marks) 

Answer any FIVE questions out of SEVEN questions 

[All questions carry equal marks] 

13. Discuss the characteristics primary and secondary memory. 

14. Discuss the first generation of computer. 

15. Explain the uses of Ms-word document. 

16. Explain about Ms excel and its uses. 
17. Explain the values central process and arithmetic logical unit. 

18. Summarize the different computer based technology. 

19. Draw a sketch of uses of PowerPoint presentation. 

PART - C (1x10=10 Marks) 

CASE STUDY (Covering the Whole Course) 

20. Write a mail merge command for the following documentation, 

assume that you have invite your friends for the New year 

celebration at your office to create one get to gather function and 

write your friend a letter to at least 25 members using mail merge 

wizard, based on one document is letter another one document is 

your friend envelop address using table format.  
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SWAYAM PRABHA 

The SWAYAM PRABHA is a group of 40 DTH channels devoted to 

telecasting of high-quality educational programmes on 24X7 basis using 

the GSAT-15 satellite. Every day, there will be new content for at least 

(4) hours which would be repeated 5 more times in a day, allowing the 

students to choose the time of their convenience. The channels are 

uplinked from BISAG-N, Gandhinagar. The contents are provided by 

IITs, UGC, CEC, IGNOU. The INFLIBNET Centre maintains the web 

portal. 

Open and Distance Learning (ODL) students of Vels Institute of 

Science, Technology and Advanced Studies(VISTAS) are advised to 

use the SWAYAM PRABHA  (A good initiative of  Ministry of Education, 

Government of India) as part of supplementary learning materials in 

addition to the Self Learning Materials(SLM) supplied to the students. 

Open and Distance Learning (ODL) students of VISTAS can also visit 

https://swayamprabha.gov.in/ and under Higher Education can view 

the videos uploaded in the website. 



 

 



SWAYAM Prabha Channels Information 
 

Channel 

Number 
Channel Description 

Channels 01 – 10 & 40 are managed by CEC, New Delhi. 

1 Language and Literature 

2 History, Culture & Philosophy 

3 Social & Behavioral Sciences 

4 Education and Home Science 

5 Information, Communication and Management Studies 

6 Law and Legal Studies 

7 Economics and Commerce 

8 Physical and Earth Sciences 

9 Life Sciences 

10 Applied Sciences 

40 
Arts/Literature, Social Science, Management and other Professional Courses, 
Natural and Applied Science 

Channels 11 to 16 are Managed by IGNOU, New Delhi 

11 Social Sciences & Humanities 

12 Basic and Applied Sciences 

13 Professional Education 

14 State Open Universities and Gyandarshan 

15 Capacity  Building and Teacher Education 

16 Skill and Vocational Education 

Channels 17 to 20 are managed by IIT Bombay 

17 Biotechnology and Biochemical Engineering 

18 Electronics and Communication Engineering 

19 Electrical Engineering 

20 Physics 

  



Channels 21 to 22 are managed by IIT Delhi 

21 Textile Engineering 

22 IIT PAL (JEE competition assistance) 

 Channels 23 is managed by IIT Gandhinagar 

23 Civil Engineering 

Channels 24 to 28 are managed by IIT Kanpur 

24 Aeronautical Engineering 

25 Humanities and Social Sciences 

26 
Management, Law, Economics;  
Business Analytics, Communication, Cooperative Management 

27 
Mechanical Engineering, Engineering Design, Manufacturing E & T and allied 
subjects 

28 Visual communications, Graphic design, Media technology 

 Channels 29 to 30 are managed by IIT Kharagpur 

29 Architecture & Interior Design. 

30 Computer Sciences Engineering / IT & Related Branches 

Channels 31 to 35 are managed by IIT Madras 

31 Instrumentation, Control and Biomedical and Engineering 

32 Bridge Courses, Impact Series 

33 
Chemical Engineering, Nanotechnology, Environmental and Atmospheric 
Sciences 

34 Health Sciences 

35 Metallurgical and Material Science Engineering, Mining and Ocean Engineering 

36 
Skills and Logistics (IT - Enabled Sector, Banking, Financial and Insurance 
sector Skills Logistics, Supply Chain Management and Transportation, Life 
skills) 

Channels 37 to 38 are managed by IIT Tirupati 

37 Chemistry, Biochemistry and Food Processing Engineering 

38 Mathematics 

Channels 39 is managed by University of Hyderabad and National Sanskrit University 

39 
 

Performing Arts (Indian Classical Music and Dances), Theatre Arts, Film making 
and Painting 
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